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SYSTEM REQUIREMENTS 
 

The SmartLink IV software package is designed to run on personal computers 
using Microsoft® Windows 2000™, Windows XP™, and Windows Vista™ operating 
systems.  The computer system must have an adequate amount of free space on 
the hard drive for proper operation. SmartLink IV is approximately 94MB when 
installed. SmartLink IV no longer supports Windows 98™ or earlier operating 
systems.  
 
An RS232 Serial Port is required on the computer to allow communication between the 
SmartLink IV software and the ThunderMax ECM. A special RS232 communication 
cable is included in this package, allowing the user to edit maps and module settings in 
the ThunderMax ECM. A high speed internet connection is required for software, 
firmware, and Base Map Library updates.  
 

NOTES:  If your computer is not equipped with an RS-232 serial port, you will 
need to purchase a USB-to-RS232 adapter from Zipper’s. Ask for Part # 372-000 (USB 
to Serial Port Converter). Vista Users do not need to install the supplied drivers for 
proper adapter operation. If an internet connection is available, Vista will automatically 
install the drivers when the adapter is first inserted into your computer.  

 

USER REQUIREMENTS 
 

The Smartlink software requires basic computer skills to be able to effectively use the 
program and achieve your tuning goals. The operator must possess the following basic 
skills before attempting to use the software or calling Zipper’s Technical Support: 
 
 1.) Basic Windows™ Skills 

 
2.) Ability to Copy and Paste files from one folder to another 
 
3.) Maneuver through a typical Windows™ environment, storing files in 
folders and retrieving them when needed.  
 
4.) The ability to Establish an Internet Connection for software, firmware, and 
Base Map Library updates. You must have a high speed internet connection 
on the computer that you’re about to install SmartLink IV on.  
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CONTENTS OF SUPPLIED DISC 
 

The SmartLink IV disc includes the following: 
 

• SmartLink IV Software 
- Complete Base Map Library 

• SmartLink IV Tuning Manual Instructions, in .PDF format  
- Now accessible through the SmartLink Software.  

• AutoTune Demo File – Watch this sample video file of the AutoTune 
correcting for a 20% rich and a 20% lean condition. The video was created 
using a ThunderMax ECM with AutoTune on a load control dynamometer.  

 
If the SmartLink IV disc is not available, the SmartLink IV software Tuning Manual can 
be downloaded from the www.Thunder-Max.com website, under the Support section.  
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IMPORTANT NOTES 
 

• The SmartLink IV Tuning Manual contains a Glossary of Terms as well as an 
Appendix with a dialog on the menus and functions of SmartLink IV. These 
features have been added to avoid any confusion over the terminology and 
functions used in SmartLink IV and in EFI tuning in general. Please refer to the 
end of this document for these valuable tools when needed.  

• If you are using the ThunderMax controller in an open loop configuration and 
your application is not listed on the SmartLink Map Database, additional tuning 
will be required.  If the bike has small variations from the original design of the 
base map, basic adjustments or calibration will be necessary.  Please carefully 
review the instructions so the tune up can be performed smoothly with SmartLink 
IV.  

• In addition, the speedometer calibration should always be confirmed during the 
installation for your year/model motorcycle. This is critical so that your 
speedometer is calibrated and functional before road testing your new 
ThunderMax ECM. In addition, anytime a map is reloaded or a new map is 
loaded onto your ECM, the speedometer calibration needs to be set to your 
application.  

 
NOTICE to Dealers and Tuners: If you are a dealer, or an experienced 
tuner, contact your Zipper’s representative to learn about the Advanced 
authorization. The SmartLink IV Advanced software is specifically designed 
for the development of base maps, or significant base map alterations. 

 
  
The ThunderMax EFI controller is not legal for use or installation on motor vehicles 
operated on public highways, and may be restricted to closed-course competition use 
only, in the State of California and other States where similar emission control laws may 
apply. 
 
The user shall determine suitability of the product for his or her use.  Installation and 
use on a pollution-controlled vehicle, for highway use, constitutes tampering under the 
US EPA guidelines and can lead to substantial fines and penalties. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Section 2: 
 

Hardware and 
Software Installation 

 
 
 
 
 
 
 
 
 
 

 
Always pull the ECM fuse before disconnecting or reconnecting the 
battery! At any point if the ECM Fuse has been pulled, including battery 
replacement, the ThunderMax ECM must be re-initialized. See the 
initialization procedure on page 11. 
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THUNDERMAX ECM INSTALLATION 
 

NOTE: If you are removing a post fuel devise system and your throttle blade 
position has been changed from the factory setting and you are unable to set 
the blade setting back to the original position, call Zipper’s Tech Support 
before you install this unit.  

 
Follow all of the instructions located in the package and attached to the ECM to properly 
install and initialize the ThunderMax unit. Although the mounting locations are different 
for each of the three families of motorcycles (Dyna®, Softail®, and Touring), the process 
is virtually the same for all models. 

 
Please read the model specific installation instructions for your application before 
attempting to install the ThunderMax ECM. Also read the supplied QuickStart Manual 
for an abbreviated version of the installation instructions.  

 
 

Touring Model Installation: 
 

Open Loop – ThunderMax ECM Only – No AutoTune Module 
 
1.) Remove the ECM fuse 
2.) Disconnect the ECM harness 
3.) Use a 3/16 hex key to slowly turn the mounting bolts in and out, gradually 

freeing the thread locking compound. (See Installation Tips on page 26) 
4.) Remove the Stock ECM 
5.) Attach the ThunderMax ECM to the ECM Harness. 
6.) Install the ThunderMax ECM in the stock ECM location. 
7.) Install the ECM fuse 
8.) Initialize the Module (page 11). 

 
Closed Loop System – ThunderMax ECM with AutoTune 
 
 
1.) Remove the ECM fuse 
2.) Disconnect the ECM harness 
3.) Use a 3/16 hex key to slowly turn the 

mounting bolts in and out, gradually 
freeing the thread locking compound. 
(See Installation Troubleshooting below) 

4.) Remove the Stock ECM 
5.) Attach the ThunderMax ECM to the ECM 

Harness. Do not install the ECM onto the 
motorcycle at this point. If the ECM is mounted 
onto the electrical caddy at this step, it is difficult to get the fuse box in place. 

6.) Reinstall the ECM fuse; insert the ECM Block back into position. 



Installation__________________________________________ 

 10

7.) Install the ThunderMax ECM in the stock ECM location. 
8.) Wide Band Oxygen Sensor Installation 
 

Determine if your application currently has oxygen sensors installed in the 
exhaust pipes. All 2007 & Up Touring models are produced with oxygen sensors in the 
factory head pipes. If your exhaust system does not have oxygen sensor bungs (2006 – 
earlier), you will either need to install sensor bungs into your current head pipes, or 
purchase an exhaust system that has the sensor bungs already in place. If you choose 
to add the sensor bungs to your current exhaust system, the bungs must be located 
within 4-6” of the cylinder head. If you need sensor bungs, please call Zipper’s and 
request PN: 272-200 (sold individually). 
 

Aftermarket exhaust systems may or may not have the appropriate 
sensor bungs welded in place. The Bosch wide band oxygen sensors 
supplied with the Auto-Tune Kit fit ALL OEM head pipe systems 
with adequate clearance. If you have an aftermarket exhaust system, 
there may or may not be ample clearance for the taller wide band 
oxygen sensor. Please contact the exhaust system manufacturer if a 

problem occurs. Zipper’s can only create bolt-on products and kits based off of factory 
specifications and dimensions, if an aftermarket manufacturer has not followed the 
factory locations, clearance issues may exist. Make sure the sensor does not rub the 
frame, transmission or any parts of the motorcycle that could damage the sensor. 
 
 9.) Remove the factory narrow band oxygen sensors from the exhaust 
pipes (if applicable). None of the factory equipped narrow band oxygen sensors were 
installed with an anti-seize compound, so they are generally difficult to remove. When a 
tight spot is detected, work the sensor back and forth without forcing it out. Generally a 
shot of penetrating fluid will aide in the sensor removal, carbon build up on the threads 
will be washed away with any penetrating fluid or carburetor cleaner.  

Two black connector caps are included in the Auto-Tune kit, these are supplied 
to protect the factory wiring harness from corrosion and to hide the yellow connectors 
supplied on the factory wiring harness. These wires will not be reused and should be 
tucked away from any heat emitting engine component.  
 

10.) Install the supplied wide band oxygen sensors in the front and rear 
exhaust pipes.   Check for adequate sensor clearance, the oxygen sensor, as well as 
the wiring at the end of the sensor, cannot directly contact any part of the engine, frame 
or transmission. If you are uncertain if you have adequate clearance, simply add 
clearance by creasing the pipe, or adding a new bung in the correct location. Take a 
picture and email it to ProductSupport@ZippersPerformance.com for review. 
Remember to route the sensor harness away from the engine and any components that 
emit heat.  
 

11.) Connect the wide band oxygen sensors to the closed loop module. The 
sensor wiring harnesses from the Closed Loop (AutoTune) module are labeled Front 
and Rear. The sensor wiring harness for the rear cylinder sensor is shorter and can be 
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easily identified by the “Rear” label on the harness plug. It is very important to install the 
correct wiring harness to the appropriate oxygen sensor. This step is critical or the 
engine will perform poorly! 
 

12.) Plug the Auto-Tune module into the Data Link Connector on the 
motorcycle. The Auto-Tune module uses the power supply from the Data Link 
Connector, as well as using it for data transfer to the ThunderMax ECM. A ‘Y’ harness is 
available to keep an open Data Link if desired, Zipper’s PN: 309-343. 

 

 
 

 13.) Initializing the Module 
 

a.) Turn the ignition on for 30 seconds, making sure the 
“Run / OFF” Rocker switch is in the “Run” position, DO NOT 
start the engine at this point or move the throttle during 
initialization.  
 
b.) After the ignition has been on for 30 seconds, turn the 
ignition off for 30 seconds. 
 
c.) Repeat Steps 13 a & 
b two more times 
without starting the 
engine. The module is 

now installed and initialized. 
 

 
 
 
 

The installation is now complete for your 
Touring model motorcycle. Proceed to the 
SmartLink IV Software Installation Section, 
which is found on page 27. 

ThunderMax ECM 
Module Initialization 

   

Check “Run / Off” Handlebar 
Switch in "Run" Position 

DO NOT START THE ENGINE 
Ignition ON 30 Seconds Cycle 1 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 2 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 3 
Ignition OFF 30 Seconds 
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Softail® Model Installation: 
 

Open Loop – ThunderMax ECM Only – No AutoTune Module 
 
1.) Remove the seat and the fuse box cover   
2.) Locate and remove the ECM fuse 
3.) Remove the stock ECM from the motorcycle. Use a 3/16 hex key to slowly 

turn the mounting bolts in and out, gradually freeing the thread locking 
compound. (See Installation Troubleshooting below) 

4.) Disconnect the ECM harness 
5.) Remove the Stock ECM 
6.) Attach the ThunderMax ECM to the ECM Harness. 
7.) Install the ThunderMax ECM in the stock ECM location. 
8.) Install the ECM fuse 
9.) Initialize the Module (Page 15). 

 
Closed Loop System – ThunderMax ECM with AutoTune 
 
 

Determine if your application 
currently has oxygen sensors 
installed in the exhaust pipes. 
All 2007 & Up Softail® models 
are produced with oxygen 
sensors in the factory head 
pipes. If your exhaust system 
does not have oxygen sensor 
bungs (2006 – earlier), you will 
either need to install sensor 
bungs into your current head 
pipes, or purchase an exhaust 
system that has the sensor 
bungs already in place. If you 
choose to add the sensor bungs 
to your current exhaust system, 
the bungs must be located within 4-6” of the cylinder head. If you need sensor bungs, 
please call Zipper’s and request PN: 272-200 (sold individually). 
 

Aftermarket exhaust systems may or may not have the appropriate 
sensor bungs welded in place. The Bosch wide band oxygen sensors 
supplied with the Auto-Tune Kit fit ALL of the OEM exhaust 
systems with adequate clearance. If you have an aftermarket exhaust 
system, there may or may not be ample clearance for the taller wide 
band oxygen sensor. Please contact the exhaust system manufacturer if 

a problem occurs. Zipper’s can only create bolt-on products and kits based off of factory 
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specifications and dimensions, if an aftermarket manufacturer has not followed the 
factory locations, clearance issues may exist. 
 

1.) Remove the seat and the fuse box cover.   
2.) Locate and remove the ECM fuse 
3.) Remove the stock ECM from the motorcycle. Use a 3/16 hex key to slowly 

turn the mounting bolts in and out, gradually freeing the thread locking 
compound. (See Installation Troubleshooting below) 

4.) Disconnect the ECM harness 
5.) Remove the Stock ECM 
 
 
6.) Lift the battery up 

from the oil tank and 
remove the battery 
cables (negative 
first).  Remove the 
battery.  

 
 
 
 
 
 

 
 
 
 
7.) Remove the bolts holding the fuse block bracket to the frame and lift the 

bracket away from the frame to allow access to the gap between the frame 
and oil tank on 
the right side of 
the motorcycle. 

 
 
 
 



Installation__________________________________________ 

 14

8.) Connect the ThunderMax ECM to the harness and position it loosely in the 
ECM tray.  Feed both oxygen sensor harnesses (front cylinder first) through 
the gap between the frame and oil tank on the right side of the motorcycle.   

 

     
 

 
 

9.) At this time you may want to snake the rear oxygen sensor towards the rear 
exhaust pipe by starting it from the right side of the bike, under the oil tank, 
and around the seat post to the rear exhaust position (do not connect it to the 
harness until after it has been installed and tightened into the exhaust pipe, 
so the harness can turn freely).   
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10.) Position the harness plug for the front pipe under the transmission, along 
the frame rail.  Install the oxygen sensors into the exhaust pipes, connect the 
harness plugs to the oxygen sensors and secure the harnesses to the frame 
above the lowest point with wire ties.  

 

 
 

11.) Re-install the fuse block bracket bolts 
12.) Attach the ThunderMax ECM to the ECM tray.   
13.) Plug the power cable for the AutoTune module into the DataLink 
Connector on the motorcycle.  
14.) Re-install the battery (positive cable first) and then install the ECM fuse.   
15.) Initializing the Module 

 
a.) Turn the ignition on for 30 seconds, making sure the “Run / 
OFF” Rocker switch is in the “Run” position, DO NOT start the 
engine at this point or move the throttle during initialization.  
 
b.) After the ignition has 
been on for 30 seconds, turn 
the ignition off for 30 
seconds. 
 
c.) Repeat Steps 15 a & b 
two more times without 

starting the engine. The module is now 
installed and initialized. 
 

The installation is now complete for your Softail® 
model motorcycle. Proceed to the SmartLink IV 
Software Installation Section, which is found on 
page 27. 

ThunderMax ECM 
Module Initialization 

   

Check Run / Off Handlebar Switch 
in "Run" Position 

DO NOT START THE ENGINE 
Ignition ON 30 Seconds Cycle 1 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 2 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 3 
Ignition OFF 30 Seconds 
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Dyna® Model Installation: 
 

Dyna® Install (Security System with optional Siren Module) - If 
installing with the factory optioned siren module, you will need to 
program and calibrate the system before you bolt the ECM to the caddy. 
You cannot insert the Serial cable with the siren module in place. 
Complete the installation process, including starting the engine and 
testing the stability of the system. Install the ECM to the caddy only when 

you’re ready for the first test ride. Then remove the serial cable before reinstalling the 
ECM in the caddy. If you want to leave the cable hooked to the module for future tuning 
access, you will need to relocate the optional siren module.  
 
 

Open Loop – ThunderMax ECM Only – No AutoTune Module 
 
1.) Remove the left side cover to reveal the electrical caddy. Locate and remove 

the main fuse  
2.) Use a small 

screwdriver to 
release the catches 
holding the fuse 
block, relay block and 
TSSM module to the 
electrical caddy 

3.)  Unplug the main 
harness from the 
ECM and remove the 
data plug from its 
holder. 

4.) Remove the 2 hex 
head and 1 socket head mounting bolts to free the caddy for removal. 

 
5.) Remove the stock 

ECM from the 
electrical caddy.  The 
caddy must be 
slightly modified for 
additional harness 
plug clearance.  Use 
a Dremel or Roto-Zip 
tool to provide 
additional clearance 
for the harness plug 
catch; also remove 
approximately 3/8” 
from the partition support as shown. Clearance as needed.  
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6.) Because of the impossibility of 

connecting the communication 
cable without disassembly once 
assembled on FXD models, the 
cable should be permanently 
installed to the ThunderMax 
ECM.  Feed the communication 
cable through the ECM plug port 
of the caddy and mount the ECM 
to the caddy as shown.   

 
 

7.) Reinstall the caddy with 
fuse and relay blocks in 
place.  Reconnect the 
TSSM, coil and ECM 
harnesses. After 
programming and setup, the 
communication cable can 
be coiled up and kept under 
the caddy cover.  

8.) Reinstall the Main Fuse 
9.) Initialize the Module (Page 

21). 
 

Closed Loop System – ThunderMax ECM with AutoTune 
 

Determine if your application currently has oxygen sensors installed in the 
exhaust pipes. All 2006 & Up Dyna® models are produced with oxygen sensors in the 
factory head pipes. If your exhaust system does not have oxygen sensor bungs (2005 – 
earlier), you will either need to install sensor bungs into your current head pipes, or 
purchase an exhaust system that has the sensor bungs already in place. If you choose 
to add the sensor bungs to your current exhaust system, the bungs must be located 
within 4-6” of the cylinder head. If you need sensor bungs, please call Zipper’s and 
request PN: 272-200 (sold individually). 
 

Aftermarket exhaust systems may or may not have the appropriate 
sensor bungs welded in place. The Bosch wide band oxygen sensors 
supplied with the Auto-Tune Kit fit ALL of the OEM exhaust 
systems with adequate clearance. If you have an aftermarket exhaust 
system, there may or may not be ample clearance for the taller wide 
band oxygen sensor. Please contact the exhaust system manufacturer if 

a problem occurs. Zipper’s can only create bolt-on products and kits based off of factory 
specifications and dimensions, if an aftermarket manufacturer has not followed the 
factory locations, clearance issues may exist. 
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1.) Remove the left side 

cover to reveal the 
electrical caddy. Locate 
and remove the main 
fuse. 

2.) Use a small screwdriver 
to release the catches 
holding the fuse block, 
relay block and TSSM 
module to the electrical 
caddy. 

 
 

3.) Unplug the main harness from the ECM and remove the data plug from its 
holder. 

4.) Remove the 2 hex head and 1 socket head mounting bolts to free the caddy 
for removal. 

5.) Unplug the plug wires and harness from the coil and remove the caddy. 
 
6.) Remove the stock ECM 

from the electrical caddy.  
The caddy must be slightly 
modified for additional 
harness plug clearance.  
Use a Dremel or Roto-Zip 
tool to provide additional 
clearance for the harness 
plug catch; also remove 
approximately 3/8” from the 
partition support as shown. 
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7.) Because of the impossibility of connecting the communication cable without 

disassembly once assembled on FXD models, the cable should be 
permanently installed to the ThunderMax ECM.  Feed the communication 
cable and the AutoTune power harness through the ECM plug port of the 
caddy. Mount the ECM to the caddy as shown.  The oxygen sensor 
harnesses should exit towards the opposite side of the caddy. 

 

 
 

 
 

8.) Feed the front cylinder 
oxygen sensor harness 
through to the right 
side of the bike, over 
the top and to the rear 
of the starter motor.  
Reinstall the caddy 
with fuse and relay 
blocks in place.  
Reconnect the TSSM, 
coil and ECM 
harnesses.  Plug the 
closed loop module 
into the data link on the 
bike.  It is through the data port that data from the AutoTune module is 
transferred to the ThunderMax.  A ‘Y’ harness is available (# 309-343) to keep 
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an open data port if desired.  After programming and setup, the 
communication cable can be coiled up and kept under the caddy cover. 

9.) Install the supplied wide band oxygen sensors in the front and rear exhaust 
pipes. After installation, route the sensor harness away from the engine and 
along the frame when possible.  Avoid routing harnesses where moving parts 
can contact and damage the harnesses or plugs. 

10.) Connect the sensors to the closed loop module.  The sensor wiring 
harness for the rear cylinder sensor is shorter and can be easily identified by 
the labels on the harness connectors.  It is very important to install these 
correctly or the engine will perform poorly!   

11.) FXD Tips:  The rear harness mounts easily, just coil the excess wires and 
locate them above the transmission.  The front harness should travel from the 
AutoTune module, over and to the rear of the starter motor, behind the 
exhaust support bracket and between the crossover pipe and the 
transmission, as shown.  

 

 
 
12.) Remove the foot peg / brake pedal bracket mounting bolts and move the 

assembly towards the exhaust pipe.  Route the front exhaust sensor harness 
under the cam cover exhaust support bracket and behind the brake pedal; 
connect it to AutoTune harness.   
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13.) The sensor plug and harness will drop down to the frame rail with a little 

brake pedal wiggling where it can be zip-tied to the frame rail, out of sight and 
out of harm’s way.  

 

 
 

14.) Reinstall the Main Fuse 
 
15.) Initializing the Module 

 
a.) Turn the ignition on 
for 30 seconds, making 
sure the “Run / OFF” 
Rocker switch is in the 
“Run” position, DO 
NOT start the engine at 
this point or move the 
throttle during 
initialization.  
 
b.) After the ignition 
has been on for 30 

seconds, turn the ignition off for 
30 seconds. 
 
c.) Repeat Steps 1 & 2 two more times without starting the engine. The module is 
now installed and initialized. 
 
 
The installation is now complete for your Dyna® model motorcycle. Proceed to 
the SmartLink IV Software Installation Section, which is found on page 27. 

ThunderMax ECM 
Module Initialization 

   

Check Run / Off Handlebar Switch 
in "Run" Position 

DO NOT START THE ENGINE 
Ignition ON 30 Seconds Cycle 1 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 2 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 3 
Ignition OFF 30 Seconds 
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Sportster® Model Installation: 
 
Due to the mounting location and space constraints on the Sportster® for the ECM, your 
ThunderMax system is supplied with a separate AutoTune module.  The ThunderMax 
ECM mounts in the same location as the factory ECM under the seat; the AutoTune 
module must be mounted separately.   
 

1.) Remove the Seat 
2.) Open the side cover, 

remove the ECM fuse 
3.) Disconnect the ECM 

harness from the ECM 
4.) Use a 3/16 hex key to 

slowly turn the 
mounting bolts in and 
out, gradually freeing 
the thread locking 
compound. (See 
Installation 
Troubleshooting below) 

5.) Remove the Stock ECM 
6.) Attach the ThunderMax ECM to the ECM Harness.  
7.) Install the ThunderMax ECM in the stock ECM location. 
8.) AutoTune Module Installation – Mount the AutoTune module to the frame 

backbone using the supplied wire ties (right side view shown below).  Position 
housing so wires exit to the left as shown below.  
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9.) Insert communication plug into the bike’s data port (gray). The following 
picture shows the AutoTune Module on the left, and the Data Link Port to the 
right, circled in red.  

 

 
 

10.) Remove the factory oxygen sensors and install the wide-band units. 
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11.) Front: route wiring along frame rail (double up harness if necessary), 

position harness plug at lower front primary cover area. 
 

 
 

Rear: Route wiring down the left frame rail behind the primary housing, 
with the plug located along the frame turn.  Double-back the wiring to the 
rear sensor. 
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12.) Reinstall the ECM Fuse, side cover, and seat.  
 
13.) Initializing the Module  
 

a.) Turn the ignition on for 30 seconds, making sure the “Run / 
OFF” Rocker switch is in the 
“Run” position, DO NOT start the 
engine at this point or move the 
throttle during initialization.  

 
b.) After the ignition has 

been on for 30 seconds, turn 
the ignition off for 30 seconds. 

 
c.) Repeat Steps 13 a & b two more 

times without starting the engine. The 
module is now installed and initialized. 

 
 
 
The installation is now complete for your Sportster® model motorcycle. 

Proceed to the SmartLink IV Software Installation Section, which is found on 
page 27. 

ThunderMax ECM 
Module Initialization 

   

Check Run / Off Handlebar Switch 
in "Run" Position 

DO NOT START THE ENGINE 
Ignition ON 30 Seconds Cycle 1 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 2 
Ignition OFF 30 Seconds 
Ignition ON 30 Seconds Cycle 3 
Ignition OFF 30 Seconds 
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INSTALLATION TIPS 

 
Frozen Hardware on Electrical Caddy - You may encounter bolts that are frozen to 
the brass insert in the plastic tray. In this instance, the bolt and threaded brass insert will 
turn together in the plastic tray.  If this occurs, remove the tray from the motorcycle and 
apply carb cleaner in the backside of the threaded brass insert.  Allow time for 
penetration; repeat the application if required. In severe cases you may need to drill 2-6 
threads out of the bolt end in the threaded brass insert. This will introduce enough heat 
into the insert to break the Loctite® and allow the bolt to come free from the threaded 
brass insert.  
 
Dyna® Model Electrical Caddy Modification – Pre-modified OEM plastic Electrical 
Caddies are available from Zipper’s.  
 
Difficult Oxygen Sensor Removal – Work the sensor back and forth, carbon from the 
exhaust process gets caught in the threads between the oxygen sensor and the sensor 
bung; it can damage the threads if forced out. If the exhaust system is cold, spray 
carburetor cleaner, or any penetrating fluid, at the sensor threads to help break down 
the carbon build up.  
 
Wide Band Oxygen Sensor Clearance Issue – Large volume users may want to make 
an 18mm tool or “bending bar” which allows you to alter the angle of the sensor bungs.   
  



___________________________________________Installation 

 27

 SMARTLINK IV SOFTWARE INSTALLATION 
 

To install the software onto the computer system, take the following steps: 
 
1. Exit any programs that are currently running. 
 
2. Insert the SmartLink Basic Software disc into the CD-ROM drive. 
 
3. SmartLink will automatically begin the installation process, the following window will 

appear:  

 
 
4. The SmartLink Installation Wizard will now guide you through the rest of the 

installation.  
 
5. Once SmartLink IV is installed, a desktop icon named “SmartLink IV Zippers” will 

appear on your computer’s desktop. Select this new icon to open SmartLink IV. An 
unlock code is no longer necessary for installing an End User version of SmartLink 
IV.  

 
6. Configuring your engine type: A window titled “Configure: Engine Type” now appears 

with SmartLink IV versions 2008.0.2 or later. This will set the default software 
configuration, however at any point you may switch between a Big Twin / Sportster® 
or a V-Rod® configuration be selecting Configure > Product Configurations.   

 

 
7. To ensure that you are using the latest software, after the installation is complete, 

open the software by selecting the “SmartLink IV Zippers” icon that is now on your 
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desktop. Once opened, select Configure > SmartLink Update, as shown in the 
following picture. For complete instructions, see section 6 which is titled “Updates”.  

 
 
 
 
 
 
 
 
 

 
 

Error During Installation: Windows errors during installation are not 
necessarily SmartLink IV issues. Please uninstall SmartLink IV and reinsert the CD-
Rom if a problem occurs during installation.  

 
 



 

 

 
 
 
 
 
 
 

 
Section 3: 

 
Learning the Basics of 

SmartLink IV 
 
 

Although the size of the instruction manual may be intimidating, please take a moment 
to scan through the entire document to get a feel for the layout of the document.  
 
The SmartLink IV Tuning Manual is meant to be a quick, but comprehensive, reference 
book for any skill level user.  
 
In an effort to make the large document easier to navigate, a Table of Contents, Index, 
Glossary, and an Appendix with a “Visual Index” are included for quick navigation.



 

 

SMARTLINK IV SOFTWARE LAYOUT 
 
 
 

 
 
 
 

MAP IN USE IN 
SMARTLINK IV

TUNING MAP WINDOW 
– Displays the Tuning Maps that are 
selected from the Tuning Map Tree. 
From this window you will be able to 
tune the AFR and Ignition Curves.  

TUNING 
MAPS TREE 

- This is always 
visible for quick 

map page selection 
& map toggling 
during tuning 

sessions.  

MONITOR VIEW / 
GAUGES – Live Data from 

the ThunderMax ECM – 
Customizable Display & Gauge 

Features 

DROP DOWN 
MENUS 

- These menus 
contain valuable 
features which 

include browsing the 
Base Map Library, 
saving your tuning 
work, and Read / 

Write commands for  
ECM 

communication.  

BASE MAP FILE ID

MODULE BASE MAP 
ID – When Linked to the 
module, the Base Map ID is 
displayed in the Status Bar. 
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SELECTING A BASE MAP FILE  
FROM THE SMARTLINK IV DATABASE 

 
To load a Base Map File onto the ThunderMax ECM, the SmartLink IV Database will 
help you select an appropriate map to begin the tuning process. To find the Smartlink 
Database, select EFI Maps > EFI Map Listings / Definitions, as shown below.   
 

 
 
The following box should appear, with the title “Base Map Definitions”.  
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Base Map “Key Elements” 
 
Search for an appropriate map by the following “Key Elements”, in order of importance: 

 
a) Throttle Body / Injector Size & Style - Note that certain applications use an 8 

degree spray pattern, and others use a 25 degree spray pattern. 
 
b) Engine Displacement - Bore & Stroke. A correct match to the engine’s stroke is 

far more important that an exact match of engine displacement. For example, a 
2007 96ci engine would respond better to a 103ci map than a 2003 95ci map 
(modified factory 88ci engine – shorter stroke).  

 
c) Exhaust System Design – If an exact match does not appear in the Base Map 

library, select the Base Map with the closest style of exhaust system. Even if your 
brand is not an option, choosing the closest style will yield the best results. Group 
your exhaust system in one of the following three categories:  

 
i. Dual Exhaust – 100% separate exhaust pipes, short or long.  
ii. 2 into 1 Collector – both cylinder head pipes converge into one.  
iii. Factory style head pipe with crossover – dual exhaust systems with 

a cross over pipe that connects the front and rear exhaust pipes.  
 

The reason for selecting a Base Map by “Key Elements” is to find the closest Base Map 
available for your combination, by the most critical components.  
 
For example, let’s assume the engine combination in question is a 2006 88ci engine 
with 8 degree injectors. A map is found for an 88ci engine with the proper throttle body 
and 8 degree injectors, but there are no matches on the exhaust system. By browsing 
the Base Map Definitions, you find a map for an 88ci engine with the correct exhaust 
system; however this Base Map file uses a 2001-2005 throttle body and injectors. 
 
The difference in the throttle body size and injector flow will make this map a bad match. 
In this instance, using a Base Map File with the correct (#1) Throttle Body / Injector 
Size, correct (#2) Engine Size, and any exhaust (#3) will be a better selection for the 
application. Choose the exhaust system that is closest to the design of your exhaust 
and proceed forward.  

 
Please note that your engine combination’s cranking compression and 
cam selection will have a significant influence on the spark map 
curves. If you have aftermarket cams in your engine combination, select a 
Base Map that was made with aftermarket cams whenever possible.  

 
If you’re still unsure of which map to select, please email the specifications of 
your Key Elements to ProductSupport@ZippersPerformance.com. Please title 
the email “Base Map Selection” for a faster response.  
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Base Map File Browsing / Selection 
 
SmartLink IV is now much easier to browse through the library of maps to find the 
appropriate map for you. A filtering option has been added to make finding the 
appropriate map much quicker. If you double click on a map with the LEFT mouse 
button, it will select that particular map. However, if you RIGHT click on a particular 
element of a map, SmartLink will filter and hide all of the maps that do not match your 
selection. 
 
To sort the map files by a particular key element, click on the column heading, and the 
maps will be sorted by that heading. If you select “Throttle”, the Base Map Definitions 
will be sorted by the type and size of the throttle body. This will narrow down the search 
and save time when searching for a map.  
                                            
For example, the first Key Element that should be chosen is the Throttle Body size. If 
you have a Zipper’s 50 mm Throttle Body, find a map that has “’01-’05 50mm Zippers 
(4.22 Inj)” listed under the “Throttle” column and right click on the “’01-’05 50mm Zippers 
(4.22 Inj)” phrase. The Base Map Definitions will automatically hide all other maps that 
do not have this throttle body, as shown in the following picture.  
 

 
 
Now all maps displayed are for engine combinations that use a Zipper’s 50 mm Throttle 
Body with 4.22 Injectors. Notice that the “Clear Filters” button is now selectable. If you 
made a mistake and want to return to the complete library listing, select the “Clear 
Filters” button and you will start over with all Base Map Files displayed.  
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Select an engine displacement by sorting the “Engine Type” column. Right click on a 
map containing a “103ci” displacement, directly on the “103ci”. The following will appear 
if 103ci is selected as the displacement.  
 

 
 

Now select the exhaust system that is being used by right clicking on the exhaust type, 
in this example choose “Rinehart FL True Duals.” The following will appear in the Base 
Map Definitions window.  
 

 
 
For the combination of a 50mm Throttle Body on a 103 ci engine with Rinehart True 
Duals, there are seven maps filtered from the library. Continue selecting categories that 
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match your engine combination. You may have to experiment with the map selection if 
your combination does not exactly match a Zipper’s Base Map File.  
 
Once you’ve narrowed down the Base Map files to the closest match to your 
combination, check the date of the Base Map file before making the final selection. You 
may find that multiple Base Map files match your criteria, always select the Base Map 
with the latest build date. The date can be found at the far right of the “Base Map 
Definitions” window.  
 
Once the map library has been filtered down to the map that you wish to use, double 
LEFT click on the map to open the “Base Map Name Encoding” window. The following 
window should appear on the screen.  

 

 
 
Loading the Base Map File 
 
Now that you’ve selected the appropriate Base Map file for your engine combination, 
you need to load this selected Base Map into SmartLink IV.  
 
Select the “Load BaseMap” button on the “Base Map Name Encoding” window, as 
shown above. Once selected, SmartLink will load this Base Map and return to the Air / 
Fuel Ratio vs. TPS page.  
 
Now that the map is loaded into the SmartLink IV software, you must upload the file to 
your ThunderMax ECM as described on page 41. If you are installing a new Base Map 
in an already used ThunderMax ECM, please remember to clear all of the offsets from 
the module’s previous Base Map, and double check the Basic Settings (page 64).  
 

Proceed forward with the Tuning Manual, remembering that a new base 
map file will require the ECM to be initialized (page 11), the Basic 
Settings need to be checked (page 64), and all offsets must be cleared from 
the previous map.  

Loading the 
map into 

SmartLink IV 
does not Load 
the map onto 

the ECM. 
 

See Page 37 
for an 

explanation of 
writing the 
map to the 

ECM. 
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Base Map Definitions Updates 
 
To ensure that you have the complete, and up-to-date, Base Map Library, select the 
“Check Internet for Updates” button on the “Base Map Name Encoding” window, as 
shown below.  
 

 
 
 

Base Map Updates: 
 

SmartLink IV now downloads all of the new base map files when you update the Base 
Map library. Previously only the Base Map library list was updated, so if you selected a 
map from an updated library list, SmartLink needed to download the map from the 
internet before you could proceed. Now the Base Map files are all downloaded during 
the update, which simply means that the newest Base Maps are always stored on your 
computer.   
 
The following window will appear if any new maps exist in the Internet database, but do 
NOT exist on your system: 
 

 
 

You will be provided an ESTIMATE of the download time required to perform this task. 
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It is simply good practice to update the definition file when searching for a new Base 
Map file. Not only are new maps constantly being created, but the older Base Maps are 
updated occasionally as well. Once updated, you may proceed with selecting an 
appropriate Base Map for the current engine combination you are working with.  
 
If you are satisfied with the operation of your current Base Map, chances are a new 
Base Map will not make a significant difference to the operation of the motorcycle. 
Updated maps could contain spark curve or fuel management changes, or even fuel 
economy strategies.  
 

If you are unsure how to select a map after reading this section, contact 
a Zipper’s representative for assistance. This step is critical in the 
optimization of the power, economy, and overall drive-ability of your 
motorcycle. Zipper’s Performance Products is committed to customer 
satisfaction, so please do not hesitate to ask for assistance.  
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LINKING TO THE THUNDERMAX ECM 
 
1.  Install the communication cable from the PC to ECM.  

 
NOTE: Make certain that the communication cable is not resting on or near 
any part of the motorcycle that generates heat.  
 

2. Turn the ignition on, making sure the OFF/ RUN switch is in the “Run” position, but do 
not start the engine. Now press the  button in the software. The red 
background will turn green when successfully linked, indicating that the PC and ECM 
are now ready to begin communication, see picture below. 
 

 
 

 
NOTE: NEVER attempt to load or reload a complete map with the engine 
running. 
 

 
If you are NOT successful in linking to the module for the first time, please double check 
everything on the following list to verify your setup. SmartLink automatically finds the 
proper Com Port to use, so linking issues are generally rare and unrelated to the 
software itself. 
 

a.) Are the cables properly installed from the ECM to the serial or USB port on 
the computer? Remove the cables and reinstall to be certain the connection is 
solid.  

b.) Are you using a “specialized” extension cable or USB adapter? Standard, low 
cost, minimum feature, “generic” type cables and adapters are best suited for 
use with this system. Zipper’s PN # 372-000 (USB to Serial Port 
Converter). 

c.) Does the module have power? Is the ignition in the “ON” position with the 
OFF / RUN rocker switch in the “Run” Position?  

d.) If a USB to Serial Adapter has been used, did you install the drivers that 
came with the Adapter? 

NOTE: Vista Users should not install the supplied driver CD with a 
USB to Serial Converter, just plug the converter in and let Vista find 
the proper drivers by itself.  

e.) Have you set the Com Port Configuration to Automatic? Select Configure > 
Select Com Port > Automatic as shown in the following picture.  
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f.) If you are NOT successful linking with the Automatic configuration, have you 
tried each of the 12 ports to see if one works for you? 

g.) Try a new USB port on your computer. 
h.) Disable your Anti-Virus Software to see if a conflict exists.  
i.) If unable to solve the problem, please fill out the form at the end of this 

instruction manual and send the required data to the Zipper’s Technical 
Support team for assistance.  

 
USB to Serial Adapter Notes: 
 
USB 2.0 Adapters: 

It has been found that many USB V2.0 adapters do not work properly with 
SmartLink IV. If it takes over a minute to either read or write a Base Map from the 
ThunderMax ECM, double check the version of the adapter you are using. USB V1.1 
adapters transfer the data correctly and should be used exclusively.  
 
64-bit Operating Systems (XP and Vista): 

64 bit operating systems will require special drivers for any USB to serial port 
converters installed. Most converters do not come with drivers for the 64-bit versions of 
XP or Vista; however both are available online from the hardware manufacturer. Please 
Contact ProductSupport@ZippersPerformance.com if you’re experiencing hardware 
issues with a 64-bit operating system.  
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SYNCHRONIZING SMARTLINK IV 
TO THE THUNDERMAX ECM 

 
Once you have successfully linked to the ThunderMax ECM, a window will appear that 
alerts you of any differences between the map currently opened in SmartLink IV, and 
the map that’s loaded in the ThunderMax ECM.  
 

 
 
If you select “Yes,” SmartLink IV will prompt you to save the map currently open in the 
software.  
 

 
 
This helps prevent changes or edits being made to an OPEN MAP which may NOT 
have all values in synchronization with the module. This is not fool proof, but is a step in 
keeping your map in synchronization during the time you are editing, monitoring, or 
saving maps.  
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LOADING A BASE MAP FILE 
IN THE THUNDERMAX ECM 

 
Select File > WRITE Module Maps and Settings, as shown in the following picture.  
 

 
 
After the transfer bar completes, the map is loaded into the module. Reinitialize the 
module by cycling the ignition switch 3 to 4 times for the IAC to find its home position, 
see page 11.  
 
 
 

DO NOT START THE ENGINE at this point or move 
the throttle during the initialization process, the monitor 
gauges still need to be set to display the parameters 
that you wish to watch during the run session. 
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READING FROM THE THUNDERMAX ECM 
 
To read a map that was previously installed on a ThunderMax ECM, select File > READ 
Module Maps and Settings, as shown in the following picture.  
 

 
 

This will start a Progress Bar window while the settings in the onboard ECM are being 
brought to the screen. Wait until the Progress Bar is complete before attempting to work 
in SmartLink IV. This may take 15-30 seconds depending on the speed of your 
computer. 

 
Once READ, the ECM’s current map and settings will be displayed in SmartLink IV. The 
Air/Fuel vs. TPS window automatically opens first.  
 

 
IMPORTANT NOTE: Any time you are connected (linked and powered 
up) to the module, any changes you make are LIVE and affect the 
module settings and maps immediately.  You will have effectively 
modified the original base map in the module, but not the base map file 
that is saved on your hard drive or in the Base Map data base.   

 
This modified map with changes should be saved to your hard drive as a renamed 
version of the original base map file. If you unlink from the module without saving the 
changes to your modified maps folder, you can access/view those changes by re-linking 
to the module and selecting File > READ Module Maps and Settings. 
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SMARTLINK FILE MANAGEMENT 
 
Proper file management is crucial to the success of your tuning program, whether you 
are an individual or a dealer regularly installing ThunderMax ECMs. Although this is a 
relatively simple procedure, if it is not addressed and understood before the tuning 
process is begun, losing maps with valuable tuning time is inevitable.  
 
SmartLink uses “Base Map” files that save the fuel curves, ignition curves, even the 
basic settings for the Speedometer Calibration, idle RPM and the Rev limiter. All of this 
data is stored in one file which makes management of the maps relatively simple. All 
SmartLink map files have a file extension of “.slk.” Each map file name is made up of 16 
characters, the first 10 letters designate the original engine combination that the map 
was made for, and the last six numbers refer to the date on which it was created, 
updated, or last modified.  
 
It is imperative that as changes are made to the map file, the file is renamed and saved. 
Zipper’s retains all of the original map files if you lose or misplace the map given to you 
at the time of the sale. However when changes are made to a map to tune the ECM 
to a specific application, it is up to the user to save this edited base map file.  
 
You can create subfolders inside the “Modified SmartLink Maps” folder to save each 
combination that is mapped with SmartLink. The more SmartLink map files that you 
save; the easier it will be to map different combinations in the future. Even though every 
engine is different, if you build a library of map files in addition to the SmartLink Map 
Database, chances are good that any combination that arrives at your doorstep can be 
mapped by altering the closest match.   
 
As more changes are implemented, do not delete the previous modified base map file; 
simply create another map file with an updated date / name. This can save an 
Enormous amount of time if changes are made and the tune goes in the wrong 
direction. It will always be easier to reload a known good running map than try to 
manipulate a modified map back to a previous condition.  
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MAP NOTES 
 
A new “Map Notes” function has been created for keeping track of tuning changes 
directly in the map.  Select EFI Maps > Map Notes as shown below, to reveal the “Map 
Notes” window. In this window you have a clean sheet of paper to record all of your 
changes and testing results. This is a great way of logging the changes made to the 
Base Map File or values changed in the Module Configuration.  
 

 
 

 
 
Zipper’s is constantly increasing and improving the SmartLink Map Database to aide in 
tuning a variety of engine combinations. However the database will never be able to 
contain a perfect match for every conceivable combination of custom pipes, throttle 
bodies, or engine modifications available on the market today. To access the latest 
maps, update your SmartLink software and select upgrade map definitions weekly for 
the latest work.  
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SAVING AN ALTERED MAP AS A NEW FILE 
 
Now that you know how to load an existing map file, it is very important to know how to 
save the base map in a new folder. In this new folder all modified versions of the base 
map file can be stored for future use. This will allow you to make changes to your base 
map file and still have the ability to reload the original base map file if the new base map 
file does not operate as well as the provided base map file.  
 
To save the loaded map as a new file, select File > Save As… as shown in the picture 
below.  

 

 
 
The following “Save As” window will appear: 
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The folder that is opened by default is called “BaseMaps.” The easiest way to store and 
manage the new modified maps is by creating a new folder titled “My SmartLink Maps” 
in this “BaseMaps” directory. To do this, select the “New Folder” button as shown below, 
circled in red. A new folder will appear, simply type “My SmartLink Maps” and hit the 
Enter button on the keyboard.  
 

 
 
Select the new folder that was created and type the base map file name that you have 
loaded. For example: if “HEVCTGSGRG011606.slk” is loaded into SmartLink IV, enter 
the Base map file name into the “File Name:” box select the “Save” button.  
 

 
 
A duplicate base map file will be created in this location. As you make changes to the 
tuning blocks and test the outcomes, save the tested base map files in this same 
location. The last six digits of the file name should be changed to the date that the 
map file was modified. This will allow you to make multiple changes to the base map 
file’s tune-up, while retaining your previous tune-ups. By maintaining the original 10 
digits of the base map file name, SmartLink IV can still decode the name to reveal the 
engine combination that the base map file was originally intended for.  
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ENGINE MONITOR VALUES & GAUGES 
 

The “Engine Monitor” function is a helpful tool to use while performing live tuning, to 
keep a watchful eye on the vital engine data while amending maps. In addition, it is very 
helpful to diagnose problems or to make adjustments with sensors or components. This 
will allow you to view all of the important sensor values on the same screen as the map 
page while the engine is running and being tuned. 
 

 
NOTE: The Engine Monitor Values will only be Live when the ECM is 
powered up, linked to the computer, and the “Monitor” button selected.  
 
 

To display the monitor data from the ECM, click the  button, which is next 

to the  button on the toolbar.  The “Monitor” button will turn green when 
active, exactly like the “Link” button does.  
  

 
 
The engine monitor buttons and values are always to the right of the “Tuning Maps” 
tree. The monitor values will always be in this location. If any map page windows are 
maximized, these values will be hidden behind the window.  
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To select the values that you wish to monitor in the “Monitor View” portion of the 
SmartLink IV layout, select Monitoring > Monitor Setup… as shown below.  
 

 
 

The following screen will appear, with check boxes beside each Monitored Value. Each 
engine monitor with a check mark will be displayed on the “Monitor Views” section of the 
SmartLink IV layout. To return to the Monitor Gauge view window; select Monitoring > 
Monitor Setup… to return to the Monitor Gauges. This “Monitor Setup…” button will 
toggle between the Monitor Gauge / Setup windows.  
 

 
 
Please note that when the “Monitor Setup…” is selected, SmartLink IV automatically 
terminates the current Monitor session. Selecting “Monitor Setup…” should be 
performed prior to starting a live tuning session. Zipper’s recommends that you keep all 
of the values selected for the Monitor View section; this will allow you to set up the 
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Monitor Gauges without toggling back and forth between the Monitor View section and 
the “Monitor Setup…”  
The engine monitoring values can be customized into individual gauges to highlight the 
parameters that you wish to monitor during the run session. To create and customize 
the gauges, select the name of the gauge (individually) that you wish to monitor.  
 

 
 
More than one gauge can be open at once; however each parameter must be selected 
individually. For example, if the “Engine Head Temp” button is selected, the following 
window will appear.  
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In this dialog, select the box next to the “Activate Gauge Display” gauge option. 
Checking this option tells SmartLink IV that you want the gauge values shown for easy 
viewing during the tuning process.  
 

 
 

This will tell the gauge to appear whenever monitoring is in effect OR whenever gauges 
are toggled from the menu bar, as shown below. To toggle the visibility of the gauges 
while Linked to the ThunderMax ECM and monitoring, select Monitoring > Show 
Gauges. 
 

 
 
Also within the Monitor Display Setup dialog you can custom design gauges to 
represent low, normal and high ranges as desired, and set each range of the individual 
gauges you want to monitor.  Colors will read on your computer monitor (yellow, green 
and red respectively) as set by your parameters. 
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The “Operational Ranges” parameters are entered as values based on the “normal” 
units of the selected monitor.  In this case “degrees F” are the units and the low range 
(yellow) is from 0 to 120 degrees F and the high range (red) will be anything above 310 
degrees F.  That leaves the green range (which is listed as white) as 120-310 degrees 
F.  If you enter invalid entries, the software will make corrections and let you verify the 
changes.  This occurs when you OK the dialog box.  
 
The following monitor gauge represents what you have just created. When the 
temperature rises above the 310o limit, the gauge turns from Green to Red and begins 
flashing, to immediately bring your attention to the temperature of the cylinder head. 
Although SmartLink cannot prevent an engine from overheating, if used properly, the 
Monitor Gauge function will alert you well in advance that the temperature is too high to 
continue operation.  
 

 
 
The next portion of the Monitor Display Setup is the Gauge Value Limits section. From 
here you will set the minimum and maximum ranges the gauge will represent. 
 

 
 
In this case the gauge limits are from 50 – 400 degrees F. 
 
More appropriate limits and ranges may be desired. Experiment with these values to 
see how they affect the gauges.  All Gauge Value Limits, gauge visibility and the gauge 
location are saved upon exit of the SmartLink IV program. 
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The final section of the Monitor Display Setup is called “Gauge Display Dampening”. 
You will notice after using SmartLink IV for the first time that some of the gauges are 
constantly changing or varying between a series of values. This is in part due to the 
sensitivity and sampling rate of the sensors used in the ThunderMax system. 
ThunderMax samples and records data much faster than the human eye can process 
the changes. To slow down the data that is being displayed, a timeframe can be 
imposed on the gauge to limit the refresh rate by up to two seconds. By default the 
Gauges are set to ½ second dampening. Experiment with these values to find the 
proper dampening for your application and preference.  
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Once the option of “Activate Gauge Display” is selected and the gauge limits are set, 
one of two things will now happen. The “Engine Head Temp” box will appear on your 
screen as shown in the following picture, if the “Link” and “Monitor” buttons have 
been activated (green background).  

 

 
 
If the monitor gauge does not appear, select Monitoring > Show Gauges as previously 
described.  Drag the gauges around your screen to customize the output to your 
preferences. To drag a Monitor Gauge, move your mouse arrow over the blue bar of the 
Monitor Gauge, then hold down the left mouse button to drag the monitor to a 
convenient location. 
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Select the most important gauges and move the boxes around to customize the look of 
the display. This is a valuable feature in Smartlink for several reasons. You can 
determine the most important parameters for your application and make changes to the 
gauges when changing from the Air / Fuel Ratio vs. TPS page to the Ignition Timing 
Maps page. A quick example of how to setup the gauges is shown below.  
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MONITOR LOGGING / REPLAY 
The Monitor Logging is created so you can record data during tuning and riding 
sessions. This feature is extremely useful to review the stability of your AFRs or when 
troubleshooting a tuning issue, an electrical problem (faulty sensor), or a mechanical 
problem like a clogged fuel filter. The Monitor Logging feature will record all of the vital 
engine operation data, and allow you to save and replay the operating session.  
 
If requested, this data file can also be emailed to Zipper’s Technical Support for analysis 
and recommendations on the tuning issue. In a Closed Loop application, with the 
AutoTune module installed, you can replay both the front and rear cylinder AFR’s as 
well as the corresponding throttle positions. This information is extremely valuable when 
modifying the AFR vs. TPS target map pages.  
 
For Open Loop only user, it is not worthwhile to record a run session for Zipper’s 
review, since no AFR’s are recorded, there is little value to the Monitor Logging 
function.  
  
How to Save a Monitor Log: 
 

1. Establish a Link to the ThunderMax ECM through SmartLink IV.  
a. Install the communications cable between the ThunderMax ECM and your 

computer. 
 
b. Turn the Ignition ON, 

and move the 
handlebar switch to the 
RUN position.  

 
 
 
c. Open SmartLink IV and select the “Link” button. 
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2. To synchronize the ThunderMax ECM to the SmartLink IV software, select File > 

READ Module Maps and Settings, as shown below.  

 
3. Now select Monitoring > Monitor Logging, as shown below. A check mark will 

appear next to Monitor Logging to confirm that the function is activated. 

 

 
 

4. Select the  button, which will turn from red to 
green.  At this time the Monitor Logging session will begin, 
with or without the engine running.   
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5. If your pre-selected Monitor Gauges did not appear, select Monitoring > Show 

Gauges, as shown below. If you have not setup your Monitor Gauges yet, please 
refer to the section called “Engine Monitor Values & Gauges” on page 47.  

 
 

 
 
6. Start the engine and allow the head temperature to rise to a normal operating 

temperature (260-285o F), and observe the gauge activity. All data is being 
logged during engine operation. Proceed with Monitor Logging as long as 
necessary to record any activity for evaluation.  

 
This may require a loaded road test or dyno pull to reveal the tuning 
problem. Road testing may not be practical unless you own a laptop and 
have adequate means of attaching and protecting the computer while the 
motorcycle is in operation. Please use caution and good sense when 
determining if a road test can be safely performed.  

 
7. Once you are complete with your Monitor Logging session, select the 

 button again to close the monitor session.  
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How to Replay a Monitor Log: 
 
1.) Now that SmartLink IV has created a Monitor Log file, you may open it for viewing by 
selecting Monitoring > Monitor Replay, as shown below.  

 
 

2.) The following window entitled “Monitor Playback Control” will appear.  

 
3.) Select the “Log File” button, which is circled in red above, and select the appropriate 
monitor log file. By default the Monitor Logs are saved by the date and time that the log 
started; which ensures that none of your previous monitor logs are accidentally 
overwritten. The following window will appear: 

 
Select the appropriate Log File and select the “Open” button.  
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4.) Select the “Play Forward” Button, as shown below, and the monitor replay will begin 
in the background. Drag the “Monitor Playback Control” window out of the way of the 
map window and the monitor gauges.  
 
 

 

 
 
 
 
 
Since SmartLink IV is replaying the monitor log like a video, you may fast forward or 
rewind the monitor session by dragging the slider or using the arrow buttons. A “Replay 
Speed Control” slider has been added to the Monitor Playback Control window for 
SMLIV Version 2008.0.2.  

New for 2008.0.2 : 
Replay Speed Control 
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Where are my Monitor Logs saved? 
 
The monitor logs are stored in the “Shared User” folder. A folder titled “ThunderHeart” 
has been created in this directory. In this instance, SmartLink IV saved the Monitor Log 
titled “WednesdayAugust012007114128.txt” in the following location on my computer, 
C:\Documents and Settings\All Users\Documents\Thunder 
Heart\SmartLinkIVZippers\MonitorLogs\WednesdayAugust012007114128.bin. A .bin file 
is also created in the same location during monitor log replaying.  
 
How do I send a Monitor Log to Zipper’s for review? 
 
The location of the monitor log is important if you need to submit your Monitor Log to 
Zipper’s Technical Support for review. Please contact 
ProductSupport@ZippersPerformance.com with your problem before emailing the 
monitor log file. When submitting a monitor log for review, please include the following 
items: 
 

1.) The Monitor Log File, only the .txt file is needed. 
2.) The Module Map File installed in your ThunderMax ECM. You must save 

the map from your ThunderMax ECM, and email the .SLK map file with the 
Monitor Log File. The AutoTune offsets and learned data that are stored in 
the map file must accompany the .txt file for proper monitor log reviewing.  

3.) The Version Number of the SmartLink IV software that you are using.  
4.) Completed Fax-In Technical Support Form, located at the end of this 

manual.  
 
To find the SmartLink IV version, select Help > About SmartLink…, as shown below.  
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Monitor Logging / Replay Troubleshooting: 
 
For Open Loop setups (No Auto-Tune), the following warning will appear: 
 

 
 
This warning is normal, it has detected that no oxygen sensors are available; click the 
“Yes” button and proceed.  



SmartLink IV__________________________________________ 

 62

 TUNING MAPS TREE 

The Tuning Maps Tree is located on the far left of the 
SmartLink IV layout, and is used to access different 
tuning and configuration pages of the software. 
Clicking on each of these tree titles opens a window 
to allow editing of a particular function: 
IAC Curves  

1.) The Idle Speed vs. Engine Temperature 
map page is primarily used to control the Idle 
Speed during a cold start warm-up period.  

2.) The IAC Stop vs. Engine Temperature map 
page is used to control the amount of air 
allowed into the engine at idle by the IAC 
Plunger.  

Air Fuel Ratio Curves 
1.) The Air/Fuel Ratio vs. TPS map page is only 

used on Open Loop ThunderMax applications 
(NO Auto-Tune).  This allows the user to alter 
the AFR at varying throttle position.  

2.) The AFR Correction vs. Engine 
Temperature map page allows the adjustment 
of the AFR correction at specific operating 
temperatures.  

3.) The AFR vs. Engine Temperature map page 
is only for Closed Loop (Auto-Tune) 

applications. This gives the Auto-Tune module AFR targets for specific operating 
temperatures.  

Ignition Timing Maps  
There are now 34 map pages for complete spark curve manipulation. The first 32 map 
pages are called “Timing vs. TPS @ RPM” map pages. These pages show the 
complete spark curves for every 256 RPM, and every throttle position.   
In addition to the complete spark curve map pages, two separate map pages have been 
created called “Rear Timing vs. TPS” and “Timing vs. Engine Speed.” The “Rear Timing 
vs. TPS” map page allows you to modify the timing in the rear cylinder only, to combat 
issues of spark knock that occurs only on the rear cylinder. The “Timing vs. Engine 
Speed” map page is a composite map page similar to the previous SmartLink versions. 
This table allows you to make quick changes to the master spark curve maps at specific 
RPMs. This map page is very effective in dealing with spark knock problems in 
particular areas. See page 88, in the “Tuning the ThunderMax ECM with Smartlink IV” 
section, for a complete discussion on how to tune the Ignition Timing Maps.  
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Air/Fuel-TPS @ RPM 
The Air/Fuel Ratio vs. TPS map pages allow you to set the AFR targets for the Closed 
Loop Operation (Auto-Tune). These 32 map pages allow you to adjust the AFR for 
every 256 RPMs of operation, with 32 throttle positions per RPM map page. This totals 
1024 points of adjustment for the AFR. This gives you the option to refine the AFR from 
idle all the way up to wide open throttle (WOT) individually. These map pages will allow 
you to set specific areas for fuel economy (standard cruising RPM and TPS), but set the 
higher RPM pages for maximum power. This is a giant leap beyond the carburetored 
era, no longer do you have to sacrifice fuel economy across the board to improve or 
maintain peak output at wide open throttle.  
 

Module Configuration  
1.) Basic Settings – The Basic Settings page is used for editing the Idle Speed, 

RPM limit, Speedometer Calibration, Accel Fuel (accelerator pump simulation), 
Initial fuel pulse IAC stops targets, limits to offsets and IAC Home Position. 

2.) Warranty Information – The ThunderMax ECM is constantly data logging while 
you ride and tune the motorcycle. The purpose of this page is to log the time that 
you spend at certain RPM ranges, as well as head temperatures, cycle time per 
riding session, and even how many times the Rev Limiter has been hit. This may 
sound intimidating, but the information is extremely valuable to you. These 
functions will aide any technician in determining why a certain failure occurred. 
The more data that you can provide to Technical Support the easier (and 
quicker!) it will be for them to help you.  

3.) Diagnostic Trouble Codes – The ThunderMax ECM can quickly tell you if any 
of the 38 sensor functions are operating properly or not. If a sensor has failed, 
you will immediately see what the problem is on this page. 
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MODULE CONFIGURATION 
BASIC SETTINGS OVERVIEW 

 
As described in the previous section, select the Module Configuration pages in the 
Tuning Maps Tree. Select the “Basic Settings” page under the “Module 
Configuration” heading. Double click “Basic Settings” to open.  The following window 
will appear.  
 

 
 
Notice that the selections on the right-hand portion of the “Basic Settings” window are 
grey and non-selectable. The features are only available for modules that are using 
Firmware version 4.8. Please upgrade your firmware by the instructions given on page 
131, and the new features will be accessible.  
 
 

 
ALWAYS read your map before making any changes to your Basic Settings. 
After making a change to any of the Basic Settings, ALWAYS WRITE 
Module Maps and Settings to your ThunderMax ECM before ending the 
Linked session.  
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The following window will appear once the Firmware is upgraded to version 4.8: 
 

 
 
New “Basic Settings” Features for SmartLink IV 2008.0.2 with Firmware 4.8: 
 

1.) Auto Tune Low Temp – The low head temperature threshold that the Auto 
Tune module begins tuning at.  
2.) Auto Tune High Temp – The high head temperature threshold that the Auto 
Tune module stops tuning at.  
3.) Main Relay Loc – This value tells the ECM if the model is a Big Twin® or 
Sportster® based motorcycle. It is now non-adjustable by an End User, the value 
is embedded in the Base Map. If you select a Sportster® Base Map, it will 
automatically change the Main Relay Loc value for you.  
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To change the values of the Basic Settings, simply click on the name of the function that 
needs to be changed. For example, if “Rev Limit” is selected, the “Basic Setting Value 
Entry” box will appear with a slider to adjust the value, as shown below.  

 

 
 
 

It is recommended that at this time you setup the basic settings for the ECM/ motorcycle 
you are working with. The next section is titled “Configuring the Basic Settings.” This 
section will teach you how to adjust each of the functions in the “Basic Settings” 
window, along with a tutorial on what each of these functions performs. Remember, if 
you do not understand some of the terminology that is being presented to you in the 
manual; refer to the Glossary of Terms at the end of the SmartLink IV Tuning Manual 
for assistance.  
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CONFIGURING THE BASIC SETTINGS 
 
ALWAYS read your map before making any changes to your Basic Settings. 
After making a change to any of the Basic Settings, ALWAYS WRITE 
Module Maps and Settings to your ThunderMax ECM before ending the 
Linked session.  

 

Rev Limit:   

At the Rev Limit RPM setting, the module will begin to cut spark to one or both cylinders 
as required to bring engine speed back down below this RPM. 

 
Rev Limit Tip: Know the peak RPM that the engine configuration is 
designed for.  Most V-Twin engines are not designed to run much over 
6,200 RPM.  Use caution with this setting, as a limit that is too high may 
allow mechanical damage to occur to the engine. 

Accel Fuel:   
 
This function is similar to an accelerator pump in a carburetor. As the number increases, 
more fuel is delivered to the engine during rapid throttle changes. This setting is pre-set 
to optimum specifications during the creation of the base map; yet differences in injector 
flow rates, changing closed loop targets, or other variables may require some 
adjustment to optimize throttle response. Zipper’s recommends a base setting for Accel 
fuel to be a value between 8-14. The Accel Fuel function is meant to be used to 
optimize the off-idle throttle response.  
 

 
Accel Fuel Tuning Tip - If you experience a pop or misfire in the intake 
tract while blipping the throttle at lower RPM’s, lower Accel fuel value until 
the situation improves. Use for Open Loop operation or closed loop when 
a richer than desired idle mixture is present.  

 
Speedo Cal:   
 
This setting is a calibration value, which differs in relation to certain years and/or models 
of motorcycles.  Note that an incorrect speedometer calibration can also affect other 
electronic accessory functions. Check the Speedo Cal for your year and model 
motorcycle.  
 

This step must be performed before attempting to ride the motorcycle for the 
first time. Zippers cannot be held responsible for an inaccurate speedometer 
calibration if this step is not followed or neglected. Traffic violations may 
result if your speedometer does not match your local traffic authority’s radar 
gun.  
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The entry can be from 1 to 99,999. At this time, the known base numbers are as follows: 

 
2004-2005 40960 
2006-2008 45900 Dyna® 
CVO 2008 42450 
2001-2003 4352 
2004-2006 40960 Softail® 
2007 - 2008 42450 

2002 4352 
2003 20480 

2004-2006 40960 
42450 

Touring 
2007 (16”) 
2007 (17”) 42000 

XL 883 2007 - 2008 48400 
XL 1200 2007 - 2008 46000 

 
On 2004 or later models, you may vary from these algorithms to offset different tire 
sizes and gear ratios on given models as long as the turn signals continue to cancel 
properly.  On 2003 and earlier motorcycles, if the turn signal canceling function from the 
TSSM fails to work, you will need to reset the algorithm back to the original number for 
proper TSSM operation.  For extreme gear ratio changes or accessory six-speed 
transmissions, an accessory speedometer recalibration device is recommended.  
 
One common problem deals with the turn signal canceling function. You must confirm 
the production year of your motorcycle by checking the date stamp on the original 
factory ECM. The 2003 model year motorcycles were produced for an 18 month period 
and the algorithms must be chosen for production date (2002 or 2003), not simply the 
2003 Anniversary model year date. All 03 motorcycles with an ECM with -01A or -02 
part # will use the 4352 (2002) algorithm. 
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Speedometer Calibration through the Factory Equipped Speedometer 
(No ECM Link required) 
 
Firmware version 4.5 and higher supports user programming of the Speedo cal setting 
thru the factory equipped speedometer display. The following instructions will guide you 
through the calibration process without linking to the ThunderMax ECM. Currently there 
are 8 values programmed in the ThunderMax ECM. 
 

Programmed 
Location 

Speedo 
Value 

Chart 
Value Model Breakdown 

1 10 mph 40960 Dyna® 2004-2005, Softail® & Touring 2004-2006
2 20 mph 45900 Dyna® 2006-2008 
3 30 mph 4352 Softail® 2001-2003, Touring 2002 

4 40 mph 42450 Softail® 2007, Touring (16"wheel) 2007,       
2008 CVO Dyna® 

5 50 mph 20480 Touring 2003 
6 60 mph 42000 Touring (17" wheel) 2007 
7 70 mph 48400 XL883 2007 
8 80 mph 46000 XL1200 2007 

 
For example, if you have a 2004 Dyna® model motorcycle, your programmed Speedo 
Cal is in location 1. Multiply “Location 1” by 10 mph to obtain the speedometer value of 
10 mph. For a 2007 XL883, select location 7, this equals 70 mph on the speedometer.  

 
1. Determine your Speedometer Value (mph) from the chart above. 
2. Enter the Speedo Calibration Programming Mode on the 

Speedometer by turning the ignition power on, while holding the 
throttle wide open. DO NOT START THE MOTORCYCLE with the 

throttle fully opened. 
3. The Speedometer value will begin to climb if the Programming Mode is 

properly activated. The speedometer value (mph) will begin to rise in 
increments of 10 mph. Release the throttle when your Speedometer Value 
from Step 1 is reached. The Speedometer will freeze on this calibration value 
when released. 

4. To program the new value in the ThunderMax ECM’s memory, simply activate 
the hazard flashers.  After a second or two, the speedometer value will drop 
back to zero. You are now finished and can de-activate the hazard flashers. 

 
Note: If a value has already been entered into the speedometer, the 
speedometer will immediately jump to the value previously entered. If you 
continue to hold the throttle open, the value will continue to climb by increments 
of 10 mph. If this situation occurs, turn the ignition off, then back on to restart the 
procedure.   
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Idle RPM:   
 
This setting reflects the idle speed at normal operating temperature.  This is used to 
adjust idle speed once the engine reaches full operating temperature. 
 

IAC Home Position:   

The IAC Home Position setting will determine how much air is required to pass by the 
IAC motor for the engine to start without assistance of moving the throttle plate. This 
value indicates the position (in “counts”) of the Idle Air Control (IAC) with the key in 
“RUN”, without the engine running.  This setting affects the amount of air the engine 
receives while cranking thru the IAC port.  The IAC Home Position range is from 0 (fully 
closed) to 255 (fully open) counts. 
 

IAC Home Position Tip: For 2001-2005 models, this value generally is 
between 90 and 115 counts. On 2006 models with a factory throttle body, 
58-70 counts is a standard value. A value that is too low won’t allow the 
engine to start properly.  A value that is too high may require the engine to 
crank excessively to start. If either situation exists, adjust the values by +/- 

5 points at a time to test the starting improvement.  
 
IAC Stops Target:   
 
This function provides a spread target that the IAC stops will learn to adjust below the 
IAC position. 2001-2005 (7-8) is recommended. 2006 & later (8-10) is the 
recommended values. 
 
IAC Learning Offsets (Min and Max):  
 
The ThunderMax ECM employs a constant learning function in determining the IAC 
Offsets. If setup properly, the IAC Learning function should not require a large window 
of offset learning.  
 
Final Drive Ratio:  
 
A setting for “Final Drive Ratio” is only needed on 2007 motorcycles with a 6th Gear 
Indicator light. The default value that should be used for a 2007 motorcycle is 87. 
Please note that this value is merely a compensation factor for the calibration needed to 
activate the light, not the actual Final Drive Ratio of the motorcycle. Please disregard 
this function if you do not have a 6th gear indicator lamp.  
Dyna® Model motorcycles, use a value of 84 for this setting to illuminate the light. 
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Gear 6 MIN TPS:  
 
The smallest value of throttle position that will allow 6th gear display. This function is 
only used on motorcycles equipped with OEM 6 speed transmissions and a 6th gear 
indicator light on the instrument cluster. If your application does not have a 6th gear 
indicator light, set the value to 0.  
 
The default value bikes equipped with this feature is 40. For any reason, if your 6th 
gear indicator light is inoperable, please confirm that you have firmware version 4.3 or 
later. Also confirm that the value in the 6th gear min TPS is 40. If not, enter this value 
and write it to the module. 
 
Initial Fuel Pulse:  
 
This setting will affect the way that the motorcycle starts when the engine is cold. When 
the ignition is turned on, the ThunderMax ECM tells the injector to spray a defined 
amount of fuel to prime the cylinders. The default setting is 199 for most maps. We 
suggest small changes to find the ideal setting for quick starting. Typically when 
properly tuned to the application, the engine will fire “immediately” and eliminate the 
strain on your battery from excessive cranking.  
 
The Initial Fuel Pulse will only pulse the injector once during each key cycle event. If 
you lower the setting too much, the function will provide less of an aide in cold starting 
the engine.  
 
Cranking Fuel:  
 
This allows you the option to richen or lean the fuel mixture during cranking conditions 
only. The Cranking Fuel option helps the engine start easier by delivering a rich fuel 
mixture to the engine, to promote a quicker initial combustion.    
 
Decel Fuel Cut:  
 
The “Decel Fuel Cut” option is the ON / OFF switch for the Decel Fuel Features. 
 
Using a value of (0) turns the feature off, and a value of (1) turns on this option. For 
example, if your motorcycle does not currently pop on deceleration, it is not 
recommended to activate this feature. If you are experiencing deceleration popping, 
set this value to (1) and proceed forward to setting the Decel Fuel options. 
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Decel Fuel Cut Rpm Low:  
 
The “Decel Fuel Cut RPM Low” setting should reflect the lowest RPM where the 
deceleration popping is occurring. This feature is set at 2048 RPM by default, 
however the setting is adjustable from 1280 to 3040 RPM. Simply take note of the RPM 
where the popping stops and use this for the “Decel Fuel Cut Rpm Low” value. This is 
where the fuel cut process is terminated. Fuel delivery is returned to normal below this 
RPM. 
 
Decel Fuel Cut Rpm High:   
 
The “Decel Fuel Cut RPM High” setting should reflect the highest RPM where the 
deceleration popping occurs. This feature is set at 2400 RPM by default; however the 
High setting is adjustable from 2048 to 4064 RPM. Simply take note of the RPM where 
the popping begins and set this value at that RPM. Your setting will be the rpm at which 
the Decel Fuel Cut is triggered during acceleration. 
 
The following picture depicts three scenarios to aide in your understanding of the Decel 
Fuel Cut function.  

“Action 1” represents a situation where both the Low and High Fuel Cut RPMs 
are achieved, the Decel Fuel Cut is triggered, activated, and deactivated.  

“Action 2” shows a situation where the High RPM was never achieved, and the 
Decel Fuel Cut is neither triggered nor activated.  

“Action 3” shows how once the Decel Fuel function is triggered, it will not 
deactivate until after the engine RPM falls below the Decel Fuel Cut Low RPM.  
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Decel Post Fuel Enrichment: 
 
The Decel Post Fuel Enrichment feature is similar to an accelerator pump on a 
carburetor. This enrichment feature smoothes the transition from an OFF to ON 
throttle condition and makes it as seamless as possible. This seamless transition is 
achieved by not allowing the manifold to enter a “dry” condition that can occur on long 
periods of deceleration, which may cause a pause, or a lag, in throttle response once 
the blade is opened. The Decel Post Fuel Enrichment has a range from 0 to 100, with 
the default setting of 16.08.   
 
Engine Temp Alarm Threshold:   
 
An adjustable Engine temperature alarm threshold is a new feature that allows you to 
set the cylinder head temperature when the “Check Engine” light turns on, to warn that 
the cylinder head temperature is starting to overheat.  
 
All of the individual models of motorcycles produce different amounts of heat, as well as 
dissipate the heat differently. If you are riding a motorcycle that shrouds the airflow from 
the cylinder heads, the engine will maintain a higher operational temperature over the 
models that do not obstruct the air from the engine. These are air-cooled engines, if the 
air is not flowing past the engine, the engine cannot dissipate the heat.  
 
Now you can select at what temperature you want to be warned, either raising the value 
for motorcycles that are constantly tripping the “Check Engine” light, or lowering the 
value if you want an early warning of a heat build up situation. Previously, the “Check 
Engine” head temperature warning value was set at 325 degrees. This setting created 
some alarm for those not familiar with the feature, so the value has been raised to 350 
degrees in firmware 4.6 and higher.  
 
Main Relay LOC:  
 
This setting is no longer adjustable by End Users. The Main Relay Loc value 
distinguishes between a Big Twin and a Sportster model motorcycle. This value is 
embedded in the Base Map file and no longer needs to be altered. Sportster model 
motorcycles will be in the “2 position”, and Big Twin models will be in the “1 position.” 
 
Auto Tune Low and High Temp Settings 
  
This setting is non-adjustable by End Users, and the value is tied to the Base Map. A 
Sportster model motorcycle requires a higher head temperature tuning range than a Big 
Twin motorcycle, and the values are set accordingly. 
  
If your application requires a special temperature threshold, please contact Zipper’s 
support.  
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Read/Write Basic Settings:  
 
The buttons at the bottom of the Module Configuration window allow you to immediately 
save the changes made to the ECM. This is also useful when attempting to read the 
current Module Configuration settings in a module that has already been in operation.  
 
Any changes made when you’re not linked to your ThunderMax ECM will result in a 
value with a yellow background. This simply means that the value is on your computer, 
but not updated to your ECM. In the following example the Decel Fuel Cut option was 
turned on, but not while linked to the ECM.  
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MODULE CONFIGURATION 
WARRANTY INFORMATION 

 
The Warranty Information window displays the amount of time that you’ve spent at 
particular RPM ranges, as well as the head temperatures that your engine has seen. 
This is extremely useful information when tuning the motorcycle. You will now be able to 
see what RPM ranges are most frequently used by your riding style. This will allow you 
to focus your tuning effort to the most frequently used ranges.  
 
The following window will appear when the “Warranty Information” option is selected. 
Select the “Read Module Logs” button to update the logged data into SmartLink IV. 
 

 
 
 

 
If you are experiencing problems viewing the Warranty Information, please 
verify that the DPI Setting (Dots Per Inch) on your computer is set at 
“Normal Size”, which is 96 DPI. Any value other than 96 DPI may not allow 
this window to open properly. Generally a higher DPI value will eliminate all 

of the buttons found at the bottom of the window. If you don’t see the “Read Module 
Logs” button, double check the DPI setting.  
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The warranty information function is viewed as two separate logs, one based on RPM 
and one based on Head Temperature. To toggle between the logs, simply select which 
log you wish to view from the two separate Log buttons, as shown below.  
 

 
 
If the “Head Temp Logs” button is selected, the following window will appear.  
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Saving the Warranty Information Data: 
 
To save the Warranty Information data that is stored in the ThunderMax ECM, first 
select the “Save to File” button at the bottom of the “Service Settings” window, as 
shown below.  
 

 
 
Once the “Save to File” button is selected, a window will appear titled “Save As.” 
 

 
 
Select “Open” and an Excel spreadsheet will be created in the directory “C:\Documents 
and Settings\All Users\Documents\Thunder Heart\SmartLinkIVZippers\WarrantyData.”  
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Two files will be created when a Warranty Data Log is saved. The first file is an Excel 
Spreadsheet that contains ALL of the data displayed on the “Service Settings” window, 
including both Head Temperature and RPM logs. This Excel spreadsheet can be printed 
out for your reference.  
 
The second file that is created is an .SSD file which can be opened through SmartLink 
IV. If you select the “Load from File” button, as shown below, SmartLink will reopen the 
saved warranty log data for viewing.  
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MODULE CONFIGURATION 
DIAGNOSTIC TROUBLE CODES 

 
When the Diagnostic Codes option is selected from the Tuning Tree, the following 
window will appear: 
 

 
 
Select “Read Diagnostic Codes” when linked to your ThunderMax ECM to 
download the Diagnostic Trouble Codes.  
 
The Diagnostic Trouble Codes window displays the current and historical errors for of all 
of the sensors and devices that are necessary for the proper operation of your 
motorcycle. This window eliminates the need for the factory scan tool for reading trouble 
codes. Instead of outputting a trouble code, this window will display the status of the 
electronics without any confusing codes.  
 
If you select the “Help” button, the following window will appear: 
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The “Diagnostic Trouble Codes – Help” window explains the setup of the Diagnostic 
Trouble Code (DTC) window. Three types of messages are given in the DTC window, 
Current errors, Historic Errors, and a message if and when a Fault has occurred, but is 
no longer present.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Current Fault 
– A fault is 
occurring with 
the sensor in 
question. A 
TPS Low 
“Current Fault” 
simply means 
that the sensor 
voltage is 
currently too 
low to operate 
correctly.  

Historic Fault – 
The fault has 
happened in the 
past, or is a present 
problem if “Current 
Fault” is displayed 
as well. If only the 
Historic Fault is 
shown, and no 
issues are found 
with the motorcycle, 
there is no reason to 
raise concern.  

Fault 47 sec – A 
fault is now 
occurring and has 
continuously 
occurred for the 
past 47 seconds. 
While counting, this 
is also is a “Current 
Fault.” The 
maximum value is 
255 seconds, which 
indicated a 
constantly occurring 
issue. 
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The Diagnostic Trouble Codes are very useful when troubleshooting issues that may or 
may not be directly related to the ThunderMax. If an error is occurring with a sensor, but 
you only see a Historic Code, use the “Clear Diagnostic Codes” button to clear the 
historic codes. If the problem happens again, it will reappear in the Historic Fault 
column.  
 
The DTC uses abbreviations for the sensor names, and it will show if the sensor voltage 
is too high, or too low for the normal operating range. 
 
TPS Low / High = Throttle Position Sensor 
MAT Low / High = Mass Air Temperature 
Head Temp Low / High = Cylinder Head Temperature 
Barometer Low / High = Barometer pressure sensor in the ECM 
EGO Front / Rear = Oxygen Sensor Front / Rear Status – The engine must be 
operating for this function to correctly diagnose the oxygen sensors.  
Battery Low / High = Main 12v Battery Voltage 
Sensor Power Low / High = Voltage across the low power sensor circuit (Factory 
equipped 5 volt sensor circuitry) 
Crank Sensor = Crank Position Sensor (CPS) 
Vehicle Speed = Vehicle Speed Sensor (VSS) 
IAC = Idle Air Control System 
Calibration Integrity = Reserved for future upgrades, currently non-functional 
Firmware Integrity = Reserved for future upgrades, currently non-functional 
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 CLOSED LOOP MODULE SETTINGS 
(Optional Settings for Auto-Tune Closed Loop) 

 
The Closed Loop Module Settings are only used when an Auto-Tune module is used in 
conjunction with the ThunderMax ECM. If the ThunderMax ECM is configured for 
Closed Loop operation, it searches for the oxygen sensors when the ignition is turn on.  
 
If the oxygen sensors are not found, the software will alert you that the oxygen sensors 
are not detected, and SmartLink will convert the ThunderMax ECM back to Open Loop 
Settings and solely operate off of the Base Map File. If the oxygen sensors are found, 
the module will directly operate off of the settings in the “Closed Loop Module Settings” 
window.  
 
The ThunderMax ECM processes feedback from the wideband oxygen sensors to 
adjust the fuel volume at all points, by creating learned “Offset” points from the installed 
‘Base Map’ fuel points. These ‘learned offset points’ are stored within the ThunderMax 
ECM and are used in conjunction with the base map. The base map is dynamically 
used by the ThunderMax ECM and the Auto-Tune’s active (closed loop) feedback 
system. The ‘base map’ fuel points are not being adjusted by either the AutoTune or 
ThunderMax ECM.   
 
To view the Closed Loop Module Settings window, select Configure > Closed Loop 
MODULE Settings… as shown below.  
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Closed Loop Configuration Layout: 
 
The Closed Loop Configuration window is broken into two distinct columns, one for the 
Module settings, and one for the Map settings.  
 

 
 
 
Enabling Closed Loop Operation: 
 

1.) Establish a communications Link to the ThunderMax ECM.  
2.) Select Configure > Closed Loop Module Settings… 
3.) Check the “Close Loop Processing (Map)” options on both sides of 

the window, as shown below.  
 

 

Left Side 
(Module Side) 

 
Closed Loop 

Settings saved  
in your 

ThunderMax 
ECM. 

 
 Changes made to 
the Module side 
are only saved if 

Linked to an 
ECM.   

Right Side 
(Map Side) 

 
Closed Loop 

Settings saved to 
the Map file on 
your computer. 

 
Any changes 

made to the Map 
side must be 
written to the 

ECM before the 
changes are 

implemented by 
the ThunderMax 

ECM. 
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4.) Select the “Write (Map) Settings To (Module)” button at the bottom of the 

Closed Loop Configuration window. 
 

 
 
If you do not have an Auto-Tune module installed, an error message will appear to alert 
you that the oxygen sensors have not been found. If this occurs the ThunderMax will 
default back to an Open Loop environment.  

 
 

Air Fuel Ratio Override: Race mode 
 
The Air Fuel Ratio Override function overrides ALL ‘Air/Fuel Ratio vs. TPS’ pages at 
ALL RPM’s. When you select the AFR (Map) button, the following box will appear to 
allow you to change your Target AFR. Once adjusted, select the “Write (Map) Settings 
To (Module)” button again to update the ThunderMax ECM.  
 

 
 
To target specific Air/Fuel Ratio RPM ranges and throttle positions, leave this box 
unchecked and edit the individual ‘Air/Fuel-TPS @ rpm’ map pages located under the 
‘Tuning Maps’ tree, see page 110 for detailed instructions.   
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Idle Air Control Override: 
 
During Normal Operation, always keep the Idle Air Control Override unchecked.  This 
setting should not be enabled except for diagnosing a particular type of supported 
problem or during tuning on a load cell dyno.  Enabling the IAC Override during 
normal operating conditions will create starting and running problems.  
 

 
  
 

 
 
 

 
 
Maximum CLP Offsets: 
 
The Maximum CLP Offsets allows you to adjust the amount of Closed Loop learning 
corrections. This simply means that you can alter the range that the Auto-Tune unit can 
tune away from the Base Map file, with a limit on allowed tuning per session, as well as 
an overall limit regardless of time.  
 

 
 
The “Session (Map)” button sets the AFR maximum learning correction from the Base 
Map’s fuel setting, per session; by percentage (range is 0-50%).  A ‘session’ is defined 
as the period of time from engine on to engine off (per cycle).   
 
The “Maximum (Map)” button sets the total AFR maximum learning correction from the 
base map’s fuel setting by percentage (regardless of number of sessions; range is 0-
50%).  
 
Unless your application is a considerable mismatch to the installed base map, the 
default settings of 5% per session and 20% maximum are sufficient for most AFR 
corrections. If the Base Map selection is a poor match to the application, the amount of 
learning needed will be significant. If the closest Base Map match is significantly 
different from your combination, increase the CLP Offsets to broaden the learning range 
per session. This will reduce the amount of time the ThunderMax needs to learn the 
appropriate fuel points. Once the tune up is close, adjust these settings back to 5% and 
20%.  

Only enable the IAC 
Override for 
troubleshooting 
purposes, when 
advised by Zipper’s. 
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SMARTLINK IV HOT KEY COMBINATIONS 
 

At any point when SmartLink IV is open, if you select the “F2” button, the following 
display will appear, titled “Hot Key Combinations”.  
 

 
 

The SmartLink IV Hot Keys are meant for users who are comfortable with the layout and 
features of the software, but are looking for a quicker means of navigating the software.  
 
Essential SmartLink IV Hot Keys 
 
[Home] – The Home key will select the FIRST tuning block map point on the displayed 
map file page. (Leftmost map point) 
[End] – The End key will select the LAST tuning block map point on the displayed map 
file page. (Rightmost map point) 
[Spacebar] – The spacebar will toggle the “Tuning Block Details” box, which displays 
the live data associated with each tuning block.  
[◄►] – The left and right arrow keys, ◄►, allow you to move between 
highlighted, or active, tuning blocks.  
[▲▼] – The up and down arrow keys, ▲▼, allow you to move a highlighted 
tuning block either up or down. Quite simply it’s the arrow keys that allow you to 
navigate through the Base Map File map pages and make adjustments to the 
tuning blocks.    
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Tuning Related SmartLink IV Hot Keys 
 
[L]  - To create a linear line between two points, tap the L key on the first point, then 
move to the second point and tap the L key.  
 
[L][L] – To create a horizontal line from a selected tuning block to the end of the map 
page (right-hand side), tap the L key twice in a row.  
 
[CTRL] [L] – If you decide to undo an [L][L] command, holding down the Control [CTRL] 
key and selecting the L key again will undo the last linear line command. 
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TUNING OVERVIEW 
Open Loop 

 
There are several ways to approach tuning, if it is required for your application. The 
method of tuning in open loop is on a load control dynamometer with 2 wide band O2 
sensors measuring each cylinder’s AFR value. Another option is to use a portable wide 
band AFR meter to generate the data needed to adjust your map. With this equipment, 
and the SmartLink IV tuning software, you can monitor and adjust specific AFRs under 
varying loads. However, this work is quite laborious and therefore expensive.  
 
Understandably, if you don’t have this type of equipment you should strongly consider 
adding the ThunderMax with an AutoTune system. This system requires 2 bungs to be 
added in the head pipes for oxygen sensors (2006 & earlier Delphi Based Factory EFI 
motorcycles) to upgrade to a ThunderMax wide band closed loop system. The 
AutoTune module receives power from the factory Diagnostics Port, for an easy plug-in 
installation. This “All in one” package can save significant time in properly tuning your 
motorcycle. 
 

IMPORTANT NOTE 
Any work on a chassis dynamometer, power sampling or live tuning, must be 
performed after the engine has reached full operating temperature. The map is 
designed to be stable and make optimum power at full operating temperature; anything 
below that may result in sampling of an engine that is still in warm-up mode (running in 
a richer AFR TARGET fuel map).  Changing a fuel map while the engine is in warm-
up mode will proportionally affect the main (operating temperature) map, with 
possibly adverse results.  Always make adjustments at normal operating temperature.  
 

 

The “Tuning 
Blocks” can 
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down by using 
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Keys (▲▼) on 
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IDLE SPEED VS ENGINE TEMPERATURE 

 
 
The Idle Speed vs. Engine Temperature map page is a graph comparing the engine 
temperature to a designated RPM. Generally speaking as the engine temperature rises, 
the idle RPM will decrease.   
 
The ThunderMax ECM uses this page to dictate the idle RPM of your motorcycle. The 
Idle Speed vs. Engine Temperature map page is changed by the Idle RPM value in 
the Basic Settings window. Changes to the “Basic Settings” Idle Rpm will change this 
Idle Speed vs. Engine Temperature map page for you in the normal operating 
temperature range. Please read the appropriate section that follows; either Open Loop 
or Closed Loop depending on your configuration.  
 
Open Loop: The Base Map has been calibrated to the default idle RPM. To significantly 
alter the idle rpm, a variety of map pages will be affected, so it is not recommended to 
perform this in open loop. If you desire to significantly lower or raise the idle from the 
default setting, it is recommended that you convert your open loop system to closed 
loop with the Auto-Tune module. The only way to significantly change the idle in open 
loop is to make changes to several of the lower RPM map pages. To achieve this 
properly, a load-cell dynamometer and oxygen sensing equipment will be required. If 
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you do not have this type of equipment, it will be less expensive to convert your 
ThunderMax to Closed Loop.  
 
Small changes can be acceptable in open loop; Zipper’s recommends only going +/- 50 
rpm from the default idle setting to maintain a stable AFR.  
 
Closed Loop: (Auto-Tune Module) - Most of the base maps in the ThunderMax data 
base are calibrated to idle between 960-1008 RPM. To reduce the idle speed, the low 
speed map pages must be recalibrated. This is done by lowering the idle speed in 
increments of no more than 100 RPMs and running the engine to allow learning of the 
map pages. Once the AFR becomes stable, you can further lower the idle speed until 
the desired RPM is reached.  
 
If you decide to change the Idle RPM of your motorcycle, please note that changes are 
automatically made to the “Idle Speed vs. Engine Temperature” map page. Changing 
the Idle RPM in the “Basic Settings” Window only changes the Idle Speed vs. Engine 
Temperature map page in normal operating conditions. Make any further adjustments 
manually, if necessary, after you have reached your desired Idle RPM. Please examine 
the following map page shown; this is an example of what happens when you alter the 
Idle RPM from 976 to 816.  
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The Idle Speed vs. Engine Temperature map page now shows the current and previous 
positions of the tuning blocks. At 317 degrees, the map begins to climb back up to the 
default Idle RPM. It is recommended to blend the end of the curve to match the normal 
operating temperature Idle RPM. Select the 310 degree map point, then select the “L” 
button twice to activate the SmartLink IV Hot Key [L][L] Straight Line fit function. The 
curve should now follow the normal operating temperature Idle to the right side of the 
map page, as shown below.  
 

 
 
The reason for reducing the Idle RPM in a high heat situation is quite simple. A lower 
Idle RPM produces less heat. This will slow down the build up of heat, which reduces 
engine power, prematurely wears key engine parts, and ultimately can cause a 
catastrophic failure. If your Idle RPM is set at 864 RPM, you do not want the idle to 
increase when it hits 317 degrees.  
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The following picture shows an Idle Speed vs. Engine Temperature map page that has 
been modified to include a lower idle at higher head temperatures with the default Idle 
RPM. At 317 degrees, the Idle RPM begins to lower as the head temperature increases, 
by 338 degrees, the Idle RPM is 864. Each motorcycle is slightly different, experiment 
with lower Idle RPMs to find the lowest stable Idle RPM. Too low of an Idle RPM and 
the motorcycle will begin to vibrate excessively, as well as reducing the oil pressure and 
charging capability. Use Caution when altering the Idle RPM significantly. 
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IAC STOP VS ENGINE TEMPERATURE 
 

 
 
The purpose of adjusting the IAC Stops is to help bring the engine speed back to the 
proper idle speed during the variety of conditions that occur when the throttle is closed.   
The IAC function compensates for the manufacturing variables associated with the fuel 
injectors, the fuel pressure regulator, and the throttle blade fit in the throttle body. The 
variables of the Air Fuel Ratio are caused by different engine combinations and the 
variance in the airflow of the throttle body, either caused by calibration of the adjusting 
screw as per the factory settings or by wide manufacturing tolerances associated with 
the production of the stock throttle body in the 2001-2005 models.  
 



 

 95

IAC Min/Max Learning Offsets: 
 
In the “Basic Settings” window, you will find two options related to the IAC learning 
function, IAC MIN Learning Offset, and IAC MAX Learning Offset. The IAC Learning 
function can learn up 1 step per session, and down 10 steps.  
 

 
 
These offsets define a range of values that the ThunderMax ECM is allowed to learn 
within. By default the IAC is allowed to learn 10 steps above, and 10 steps below the 
original Base Map file.  
 
IAC Curve Problem Solving: 
 
IAC Position Value is too low:  The system hasn’t been properly initialized. Reinitialize 
the module by cycling the power on & off, this establishes the proper position for the 
IAC motor.  See page 11 for the complete ThunderMax ECM Initialization procedure.  
 
Rough Idle, Engine Does Not Start, or Does Not Stay Running:  
The wrong map may be selected for the application, or the AFR is so far off that the 
engine will not stay running.  If you are operating in Open Loop (no Auto-Tune), Double 
check the definitions of the map that you are using, then install a probe in the tail pipe to 
determine the AFR. 
 
Excessively High Idle: 
If the ECM has previously been mounted on another motorcycle, or older firmware has 
recently been updated, the IAC stops will have learned offsets that need to be cleared. 
To clear the offsets, select Map Editing > Clear “Learned Idle Control Adjustments 
(IAC)”.  
 
Hardware to Check when IAC Problem Solving: 
 
If you are using a S.E. throttle body and are experiencing unusual engine 
operation (Idle Instability), immediately check the Intake Flange seals. These 
flanges are prone to cracking during installation & operation due to the material 
selection of the flanges. Air leaks have become very common on these throttle bodies 
due to the flanges cracking at the U shaped slot for the flange bolt. If you find that the 
flanges are cracked, do not attempt to replace with another set of the exact same 
flanges, as the inferior material used will continue cracking. Billet flanges are available 
from Zipper’s to solve this common problem, (Zipper’s PN: 117-059). 
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The second item to check on the S.E. throttle bodies is the throttle blade calibration. 
These throttle bodies are not calibrated from the manufacturer, and provide no method 
to easily calibrate the throttle blade opening. The symptoms to look for are poor idle, 
erratic behavior during warm up, or starts then stalls. If this engine runs great once 
it’s warm and off idle, the throttle body calibration is more than likely the culprit.  
 
 
The following is a basic procedure to roughly calibrate a throttle body: 
 

1.) You must acquire a special tool in order to move the set screw on the S.E. 
throttle body. Snap-On tool # TTXR15TPE will help you perform this task. If the throttle 
stop screw does not touch the crank, adjust until there is slight contact. 

 
2.) Install the throttle body assembly and properly adjust the cables. Open the 

throttle blade and place a long blade feeler gauge, 0.003” thick, below the bottom of the 
throttle plate. Then gently close the throttle onto the stop. Ideally you want some 
resistance as you pull the feeler gauge from underneath the throttle blade.  

 
If resistance is not present, adjust the set screw until you have achieved this. 

Once complete, make certain that the adjustment screw is secured in the throttle body 
casting, or use Loctite to secure your setting.  

 
3.) After the proper map is selected and loaded, re-initialize the ThunderMax 

ECM.  
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AIR/FUEL RATIO VS TPS 
(Open Loop Only) 

 

 
 

The Air / Fuel Ratio vs. TPS map page can be used to make quick and easy 
adjustments to the air/fuel ratio at different throttle positions.  If you want to make 
changes, it is best to base the change on the following: 

  
(1) Desired improvement in fuel economy at a specific throttle position range 

(Leaner) 
(2) More H.P. which may require additional fuel (Richer) 
(3) Accurate O2 data which will suggest what areas should be adjusted 
(4) Drivability issues or problems at certain throttle positions 

 
Information gathered from a commercially available oxygen sensor, that can display and 
record the engine’s A/F ratio under a variety of conditions, is very informative. These 
systems require a wide band oxygen sensor to be installed in the head pipes, or a tail 
pipe probe for each cylinder, for accurate AFR measuring. Without these systems, 
Open Loop tuning will be a difficult task. 
 
If you are using a tailpipe probe on a chassis dynamometer we suggest that you have 
the probe installed throughout the length of the pipe less 4-6 inches so you can get a 
stable reading in the heat zone of the pipe.  Wide band readers will not produce 
predictable data in low heat areas of the pipe, and are susceptible to exhaust reversion 

RICHER 
 
 
LEANER 

Select the Map 
page with your 
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Focus to the 
window. 
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that can skew the data. If you have the proper instruments for AFR recording and load 
control, contact Zipper’s and ask about the Advanced Tuner Software.  

 
Each block in the Air/Fuel Ratio settings box allows you to adjust the fuel for a particular 
throttle position.  Engine load is displayed as throttle position points in 1.6-degree 
increments from 0 to 88.7 degrees (wide-open throttle).  This is a similar adjustment to 
changing the jets in a carburetor.  The range represents an increasing load from 0 to full 
throttle.  Each block can be adjusted from the original setting plus 10% to minus10% of 
fuel from the installed base map.  

 
Modifying an Air/Fuel Ratio Map (OPEN LOOP ONLY): 
 

1. Establish a module link as described in the Linking to the ECM section. 
 
2. Read Module Map & Settings – Now that you’re linked to the ThunderMax 

ECM, select File > Read Module Map & Settings to synchronize the ECM to the 
SmartLink IV software. 

 
3. Go to the Tuning Maps Tree and select the Air/Fuel Ratio vs. TPS (Open Loop 

Only) map to adjust the module settings at the throttle position(s) and RPM range 
where tuning is required. Select a point of adjustment using the left/right arrow 
keys; to view throttle position and percentage of change at the point of 
adjustment, strike the space bar and a window will appear showing the throttle 
position at that point and the amount of fuel that will be added or subtracted by 
moving the point with the up and down arrow keys.  

 
The following map page shows where fuel has been added to the amount supplied in 
the base map. Each block can be raised (Richened) or lowered (Leaned) from the base 
map’s centerline, or starting point. The text box shows the fuel percentage change and 
the throttle blade position each block represents. These changes can be performed live, 
with the engine running or not. During a live session, a vertical cursor line moves with 
the throttle position when the monitoring function is activated. Blend these fuel blocks 
smoothly into and out of the range that has been identified as a problem. See the 
picture on the following page to see the vertical cursor line and the information provided 
when the spacebar is struck during a live tuning session.  
 



 

 99

 
 

If you are attempting to tune without the benefit of a load control dynamometer, two 
options should be considered if you’re having problems:  

1.) Seek Professional Tuning Help: If you are at the end of your tuning ability 
and the bike isn’t performing as you feel it should, it may save a lot of time 
if you seek professional tuning help. The combination of a load-cell 
dynamometer, oxygen sensing equipment, and a skilled tuner may 
ultimately be the solution if your engine combination is drastically different 
from the Base Map Database scenarios. Email 
ProductSupport@ZippersPerformance.com  if you need help selecting a 
Base Map for your combination.  

2.) Consider purchasing the ThunderMax Auto-Tune Closed Loop Module. A 
ThunderMax Auto-Tune Closed Loop module will automatically correct 
changes required to your map, and literally tune while you ride your 
motorcycle. This option is best for individuals that do not have a skilled 
local tuner or anyone locally that can tune an Open Loop EFI engine. The 
Auto-Tune module is similar to having a skilled tuner riding along with you 
making adjustments as needed, however much faster than any human 
being could react.  The benefit to the AutoTune module is tremendous, 
you can achieve a more stable AFR at all throttle positions, as well as 
improved fuel economy. 
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page with your 
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Focus to the 
window. 
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AFR CORRECTION VS ENGINE TEMPERATURE 

 
 
The AFR Correction vs. Engine Temperature map page should not be used as a “tuning 
map” page; rather it should be used as path to make corrections to remedy problems 
relating to AFR stability at specific warm up engine operation temperatures.  
 
 Example- If your engine starts and runs as desired in the warm weather months yet as 
you approach the cold weather season, you observe an unstable operation only at 
specific temperatures. For example, between 37-51 degrees an unstable AFR exists, 
but once the engine exceeds 51 degrees engine idle operation is stable. Therefore you 
would not want to make alterations to Base Map Target pages that would affect the AFR 
at normal operating temperature, only make an alteration on this page. 
 
AFR Correction vs. Engine Temperature page allows you to make changes at specific 
temperatures where the problem may exist, without changing AFR’s at normal operating 
engine temperature.    
 
Closed Loop: 
 
If you are operating in closed loop, you will likely never need to adjust this page. The 
Auto-Tune module has enough adjustment to correct any potential Idle Speed issues, 
regardless of the Idle Rpm set in the “Basic Settings” window. If you are experiencing 
unstable Idle, please double check that you’ve loaded the closest Base Map to your 
application, and that your module has been properly initialized.  
 
If you attempt to make adjustments on this page always monitor the front & rear AFR’s 
in the software to measure result of your changes.   

Select the Map 
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Focus to the 
window. 
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Open Loop: 
 
This page should not be adjusted without wide band oxygen sensors in the tail pipe. 
You must measure any lean or rich conditions, as well as corresponding head 
temperature, to accurately tune the motorcycle.  

The purpose of the page is to correct a confirmed temperature related anomaly in the 
Base Map. You need to be certain what’s causing the temperature related problem 
before adjusting this page, or more problems will be created.  

Never adjust the entire map structure at all temperatures, for it will affect all engine 
operating temperatures, which will likely skew the normal operating conditions. 

Before considering adjusting this page, first allow the IAC Stops Curve to stabilize the 
IAC operation. This may take several complete operating sessions to stabilize. If the 
problem persists at all temperatures, you can add fuel thru the AFR Vs TPS page (open 
loop) map page. 
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AFR VS ENGINE TEMPERATURE 

(Closed Loop Only) 

 
 

The AFR vs. Engine Temperature map page is only used in Closed Loop (Auto-Tune) 
applications. The AFR vs. Engine Temperature Map Page works in conjunction with the 
AFR Target pages, adding correction to the AFR’s at specific engine temperatures. 
 
For example, if you observe the AFR in both cylinders, in conjunction with the AFR 
target window on the monitor page, you will notice the target AFR leans out as the 
engine approaches normal operating temperature. This phenomenon is the AFR vs. 
Engine Temperature at work.  
 
To observe the correction applied at a particular engine temperature, select the 
appropriate tuning block and press the space bar to read values. Lowering the blocks 
richens the measured AFR, and raising the blocks leans the AFR. If the measured AFR 
is too rich or too lean during lower temperature operation, adjust the blocks accordingly 
on this page to achieve the AFR set on the AFR Target page.  
 
It is not recommend that changes be made to this map page unless instructed by 
Zipper’s Technical Support.  
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IGNITION TIMING MAPS 
 
The Ignition Timing Maps feature has changed drastically from the previous versions of 
SmartLink IV. Three new main features have been added to ease the timing adjustment 
process. These new features will aide experienced tuners, as well as beginning to 
intermediate tuners, in properly adjusting the timing on the ThunderMax ECM.  
 
Previous versions of SmartLink IV only had one page which allowed the user to make 
simple adjustments to the timing set by Zipper’s. Now 34 map pages are available for 
complete timing control.  
 
Timing Features: 
 

1.) Full “Timing Curve” Map Pages are now accessible for everyone. A map 
page is available for every 256 RPM, showing the full ignition curve for each 
RPM, 32 pages total. These shapes were created on a load-cell 
dynamometer with the specific parts listed in the Base Map definitions. 
Different camshafts or higher compression combinations will require 
adjustments to these pages.    

 
2.) Rear Cylinder Adjustment – A page titled “Rear Timing vs. TPS” is now 

available, this page allows you to make fine adjustments on the Rear cylinder 
only to offset any situations where the rear cylinder requires a different timing. 
Most cases will not require Rear cylinder adjustment, only make changes 
to this page if you’ve validated that your rear cylinder requires a timing 
adjustment on a dynamometer. No data = no adjustment.  

 
3.) Timing vs. Engine Speed – This page is carried over from the previous 

SmartLink IV software, however instead of displaying a straight line to alter 
the “hidden” timing curve pages; it now shows a generalized curve across the 
RPM range. This allows for a quick view of the overall timing scheme, and 
eases adjustment with an easier to understand map page. This page shows 
the wide open throttle curve, adjustments to this page move all 64 points on 
each particular RPM curve map page. 
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Timing vs TPS @ RPM; Full Timing Curve Map Pages: 
 

 
 

The 32 Map pages that display the Timing vs. TPS @ RPM are now available to all 
users of SmartLink IV. These pages contain the complete timing curves used by the 
ThunderMax ECM. Remember that each page is a static RPM page, relating the Timing 
in degrees to the Throttle Position.  

 
You can cause serious engine damage if the timing is set too aggressively. 
If timing changes are being tested on a road environment, great care must 
be taken in watching your surroundings and staying safe.  
 

Since the Timing vs. TPS @ RPM map pages were developed at Zipper’s on 
dynamometers using sophisticated equipment, it is impossible for Zipper’s to help you 
customize each individual map page for your combination. If you only need a slight 
timing adjustment at a specific RPM, consider using the Timing vs. Engine Speed Map 
page, as described in the next section.  
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Timing Vs Engine Speed Map Page:  
 
This map page is for making quick adjustments to the ignition timing map.  It allows 
ignition timing adjustments in one-degree increments at every 256 RPM from the base 
setting of the installed map.  
 

 
 
Each point in the Timing vs. Engine Speed map page allows the tuner to adjust the 
spark timing for a particular RPM range. Moving a tuning block on this page will move 
every point on the corresponding RPM map page. For example, if you adjust the 2560 
RPM tuning block up one degree, ALL throttle position points on the 2560 RPM page 
will move up one block.  
 
If the knock is slight at a particular RPM, you may be able to remedy the situation by 
removing 1-2 degrees of timing at the Timing vs. Engine Speed page at the specific 
RPM it occurs. If the knock is more pronounced you may need to remove additional 
timing at specific throttle positions on the Timing Vs TPS pages at the specific RPM 
value you want to adjust then road test to review the changes.  
 
Attempt to adjust the timing on this composite page before altering the curves on 
the Timing vs. TPS @ RPM map pages.  
 

NOTE: Higher values of spark advance can improve response, efficiency, and 
power until you reach the point of detonation, which reduces power and can damage 
the engine.  

 
WARNING! BEWARE OF DETONATION! Severe pre-ignition or 
detonation can cause severe engine damage. If spark knock is heard or 
detonation is found by reading your spark plugs, immediately stop testing 
and retard the ignition timing at that RPM to remedy the situation. 
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Rear Timing vs. TPS (Rear Cylinder Timing Correction): 
 

 
 

The Rear Timing vs. TPS page was added to eliminate any oddities between the front 
and rear cylinder operation. The ThunderMax AutoTune system individually monitors 
and alters the fuel setting for each cylinder for optimum operation. Now you have the 
ability to individually adjust the rear cylinder’s timing in comparison to the front cylinder 
as well. Due to the differences associated with the operation of the two cylinders, the 
rear cylinder adjustment allows you to modify the spark for optimum operating 
conditions.  
 
Modifying the Rear Timing vs. TPS page does not alter the Timing vs. TPS @ RPM 
map pages. This page only offsets the output of the main spark curves, but does not 
affect the front cylinder timing at all.  
 
This page will always start as a straight line at 0% Timing Adjustment. Any adjustments 
made to this page are recorded as % Timing Adjustment by Throttle position.  
 

 
Most cases will not require Rear cylinder adjustment, only make 
changes to this page if you’ve validated that your rear cylinder 
requires a timing adjustment on a dynamometer. No data = no 
adjustment. 

ADVANCE 
 
RETARD 

Select the Map 
page with your 
mouse to Draw 

Focus to the 
window. 
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Smoothing the Blocks: 
 
It is important to “smooth” the surrounding blocks to avoid abrupt changes in timing 
settings. The following figure shows a smooth spark curve adjustment change. Since 
the Timing vs. Engine Speed page has changed from a straight line showing the 
percentage of change to the generalized spark advance curve, it should be easier to 
smooth the blocks and see the changes that are being made to the Base Map timing 
curves. Remember you can always check each individual timing curves (Timing vs. 
TPS) map pages to see the effect that has occurred. If in doubt, test the new setup, 
record your findings, and make changes as needed.  
 

 
 
 

How to find Throttle Position of Detonation (Spark Knock or Pinging): 
 
If you are attempting to tune without the benefit of a load control dynamometer, you may 
find the following suggestion helpful.  Link to the module without starting the engine with 
the monitoring function enabled, open the Air/Fuel vs. TPS window and observe the red 
vertical bar indicating active throttle position.  Twisting the throttle through its range will 
move this vertical bar.  Using masking tape; wrap tape around the throttle grip, at the 
edge closest to the switch housing.  Apply another piece of tape to the switch housing 
(base) alongside of the grip tape.  Make a mark across both pieces of tape indicating 
the throttle position at idle. See the pictures on the next page for clarification.  
 



 

 108

Using the vertical bar as a guide, make marks on the grip tape even with the base idle 
mark at ¼, ½, ¾ and full throttle.  When you can identify the location of the throttle 
position RPM during a drivability issue, you will find it very easy to pinpoint and make 
adjustments to the areas that need it. The following pictures show an example of how to 
use tape to tell an approximate TPS while using a non-load control chassis 
dynamometer.  

 
WARNING:  ANY TUNING OPERATION INVOLVING 

ACTUAL OPERATION OF THE MOTORCYCLE ON PUBLIC STREETS 
OR HIGHWAYS IS DANGEROUS!  FULL ATTENTION TO TRAFFIC 
CONDITIONS SHOULD ALWAYS BE YOUR FIRST FOCUS ANYTIME 
YOU ARE OPERATING A MOTORCYCLE ON PUBLIC ROADS.  
INATTENTION TO CONDITIONS CAN LEAD TO ACCIDENTS AND 
PERSONAL INJURY INCLUDING DEATH.   

 

 
Closed Throttle – Marked “0” 

 

 
¾ Throttle – Marked “3” 
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Timing Troubleshooting: 
 
Here are a few common scenarios that have been seen several times by Product 
Support. The first thing you need to do before you adjust the base map is to verify you 
have selected the correct map. Selecting a map with incorrect parameters is usually the 
source for spark knock problems. Take the time to verify the best possible base map 
has been selected for your application.  
 
 

1.) If you have not experienced any spark knock or detonation problems, but 
pinging develops after your last fuel stop, do you need to adjust your 
timing? As long as spark knock has not been experienced before, continue 
operation of the motorcycle, and purchase fuel from a different source before 
making any changes to your map. 
 
It is common for gasoline to be blended differently in different regions of the 
country. Touring riders will experience this much more so than riders that stay 
in one region of the country.   

 
2.) If the gasoline has not made a difference in the operation of the motorcycle, 

check that your intake & exhaust seals are not leaking, your AutoTune 
module is turned on, as well as reading the spark plugs. If excessive oil is 
found on the plugs, you may have a head gasket leak. A head gasket leak 
can cause detonation by depleting the octane rating of the fuel, allowing a 
build up of gasoline in the combustion chamber, and igniting the rich mixture 
when the temperature reaches a high enough level to pre-ignite.  

 



 

 110

AIR FUEL RATIO VS TPS @ RPM PAGES 
 “AFR TARGET PAGES”  

Closed Loop Only 
 

 
 
The “AFR Target” pages are the most important pages in the software for managing 
a highly efficient, well tuned engine. It’s the AFR Target pages that allow you to make 
maximum power and maximum fuel economy at the same time. Since the throttle 
positions are drastically different between a maximum power scenario and a best MPG 
scenario, you can dial in each section independently, and achieve both. 
 
Simply put, these are the “AFR Target Pages” that the AutoTune module is working to 
achieve during Closed Loop Tuning. To explain the strategy, there are 32 target points 
of adjustments (throttle position) per map page, with a map page for every 256 RPM’s. 
Each base map has default values which you can change to improve fuel economy at 
cruising speeds or richen up for more power at the race track. The AutoTune module 
works to maintain these targets as all of the ambient conditions involved change.   
 
There are two options for setting the AFR’s in your ThunderMax ECM.  
 
 1.) The first technique, which is the preferred method, takes more time to setup, 
yet allows you to vary the AFR targets for different RPM and Throttle Positions. This 
allows you to fine tune the AFR for economy at light loads (leaner AFR during lower 
throttle positions) at the same time as tuning for peak power in high throttle positions 
(richer AFR during heavy load or acceleration). The pay off is worth the effort, for 
increased throttle response, maximum power, and excellent fuel economy can all be 

LEANER 
 
RICHER 

Select the Map 
page with your 
mouse to Draw 

Focus to the 
window. 
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achieved simultaneously. The end result will be a perfect balance of power and 
economy even as conditions change.  

2.) Another technique in setting up the AFR Targets, which is recommended for 
racing or other special applications, can be achieved very simply in the “Closed Loop 
Module Settings” window. The option of “AFR Override” allows you to set (1) specific 
AFR for the ThunderMax ECM to target at all points and conditions. This is discussed in 
the Closed Loop Module Settings section on page 82. This choice is most popular with 
racers or dynamometer tuning for Base Map recalibration or generation or just simply 
tuning for maximum measured power output. Choosing this option will affect the 
warm-up AFR as well, which may adversely effect the operation of the 
motorcycle. 

Note: It will require several sessions for these targets to be achieved; 
provided you operate the engine at these specific RPM’s and throttle positions at 
operating temperature.   
  
 
 
AFR Target Tuning Aides: 
To simplify tuning the 32 Air/Fuel Ratio vs. TPS @ RPM map pages, “copy” and “paste” 
functions have been added to SmartLink IV. For example, if you modify your normal 
cruising RPM map page and are pleased with the results, you can now copy this curve 
and paste it into other RPM map pages. Select “Shift-Control-C” to copy the map page. 
Now scroll to the next map page and select “Shift-Control-V” to paste the copied RPM 
map page onto the new RPM map page. Select “F2” at any point to view the SmartLink 
IV Hot Keys. For example, start by modifying the 768 RPM Map Page, then paste that 
curve on all of the map pages up to the 3584 rpm page.  
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Section 5: 
 

Diagnostics and 
Troubleshooting
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BASIC DIAGNOSTIC TIPS 
   
The bulk of all ECM returns to Zipper’s are not faulty ECMs; rather the wrong map 
was selected, learned offsets were not cleared, a factory sensor has failed, or simply 
the AutoTune module is turned off. Every ThunderMax ECM is quality tested before 
the final packaging, which includes linking to the module and starting an actual 
engine. If you just installed the ECM and your engine won’t start, something is likely 
wrong with the installation (hardware or software) or something may be wrong with 
your motorcycle, reinstall your factory ECM to validate that the problem is on the 
motorcycle, not the ThunderMax ECM. The following is a quick guide on what to 
check when a problem occurs.   
 
There are a few basic steps that should be taken when attempting to troubleshoot 
problems encountered when using the ThunderMax EFI system. Before altering the 
base map in the ECM, inspect all of the components that were installed, altered or 
otherwise handled during the module installation. Loose connections and damaged 
wires, worn or melted covering, can cause significant problems and are difficult to 
diagnose. A simple check of the wiring can save you enormous amounts of time 
troubleshooting if the culprit is wiring related.  
 
Confirm the Serial Number of the map installed in your ECM. Make sure you are 
using the latest module firmware and software. Zipper’s receives support calls about 
performance problems regularly, only to find out that the correct map was not loaded 
or the default test map was still installed in the module. Make certain that you’ve 
written the selected map to the ECM, simply loading it in SmartLink IV does 
not write the map to the ECM. Also if you are using the ThunderMax Auto-Tune 
Module, make sure you’ve enabled the Auto-Tune function under the Closed Loop 
Configuration window, page 82.  
 
If you installed a ThunderMax ECM to solve an operational problem on your 
motorcycle, and the problem still exists after installing the ThunderMax ECM, it is 
likely that there is a problem with your motorcycle, not your ECM. If your 
motorcycle didn’t start or idle properly before installing the ThunderMax ECM, 
and the problem still exists, please state this upfront with Zipper’s Customer 
Support, being upfront will save you time. If the problem was pre-existing and the 
issues are stated clearly to customer support, the chances of solving the issue 
quickly are dramatically increased.  
 
When adjusting any EFI equipped engine with any level of certainty you need to be 
able to read & or record air fuel ratios. Other wise your efforts will be extremely time 
consuming with a hit or miss approach to obtaining a result. If you have no way of 
reading the AFRs (Open Loop Tuning without O2 sensing equipment), a better 
alternative will be to add ThunderMax Auto-Tune wide band closed loop module. 
This system will create offsets from your base map to maintain proper AFRs. In 
addition, with the Auto-Tune system functioning, you can record a riding session in a 
monitor log, and replay the session on your computer. This will allow you to watch 
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the AFR’s under normal riding operation. This can help reveal issues like a clogged 
fuel filter or an intake manifold seal leak. 
 
We strongly suggest you bring the engine to normal operating temperature, 
review and log the values using the “Engine Monitors” & “Monitor Logging” 
functions of the software. These values are vital in troubleshooting a problem that 
may be keeping the engine from operating properly. With the new Monitor Logging 
feature, you can log an operating session and email the data to Zipper’s Technical 
Support for review.  
 
If either AFR’s are not reading correctly in the monitor windows or (or at all), there 
may be a problem with the following: 
 

(1) The Data Port is not plugged in (Power for the Auto-Tune module) 
(2) Damaged wiring on the closed loop module 
(3) Damaged Wiring or connector of the oxygen sensor 
(4) An oxygen sensor is unplugged 
(5) An oxygen sensor is damaged or dirty 

 
To test that the oxygen sensors are active and properly working, turn the ignition on, 
yet do not start the engine. Link to the module & monitor the AFR of the Front and 
Rear cylinders using the Monitor Gauges. Read the AFR Values for the Front & Rear 
cylinders, without starting the engine. After approx. 10 seconds, the sensors should 
be calibrated. Once calibrated to the ambient air, the oxygen sensors should warm 
up to a value of 19.36 for each sensor in the monitor window.  
 
If you cannot replicate the value of 19.36, your oxygen sensors are not calibrating 
correctly. This will cause corrupt data to influence the effectiveness of the 
ThunderMax Auto-Tune module to properly follow the targets on the tuning pages. 
 
If steps 1-4 are found to be in good order, remove the sensors and inspect for soot 
build up. You can clean the sensors with a product like CRC brand "QD electronic 
cleaner" then reinstall sensors and re-perform tests.  
 
If the sensors work now correctly, or you have to replace them, you should trouble 
shoot to determine if the wrong map has been selected or the map pages need to be 
adjusted. Excessively rich AFR’s during the warm up procedure, or at normal 
operating temperatures, will ultimately coat the sensors in soot (carbon). Once the 
sensors are dirty, they may not operate correctly, which can cause corrupt data to 
influence the Auto-Tune ECM’s tuning.  
 
If your motorcycle is operating properly, and the tune up begins degrading, it is 
highly likely that a mechanical issue is influencing the Auto-Tune module. This is 
actually a great warning system; for example, let’s assume that your intake seals 
start leaking. In an open-loop EFI system, the mixture begins getting leaner, and 
leaner, creating excessive heat and multiple other issues. If you are using the 
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Closed Loop Auto-Tune system, the ECM will continue richening the mixture to 
maintain the AFR targets. Eventually you will notice a loss in power, lower fuel 
economy, and a loss in idle stability.  
 
Since the Auto-Tune module is adding additional fuel for the additional air provided 
by the leak, the engine never gets a chance to over-heat or cause significant engine 
damage. Since this is a learning system, if you feel that the tune up is deteriorating, 
more than likely the system is over-correcting a mechanical problem that must be 
fixed.  
 
Another issue that has become problematic is corrosion on the ECM connections or 
on the ECM & fuel pump fuses. Both can create conditions that are difficult to 
replicate or reproduce when troubleshooting. Both of these seals are factory 
equipped and unrelated to the ThunderMax ECM.  
 
When cleaning your motorcycle, you should never directly wash the ECM 
compartment with water! Excessive water can create a host of bizarre technical 
problems. The ECM is designed to keep water out; however, with pressurized water 
it is possible to soak the factory wiring harness connector to ECM connection.    
 
If a problem occurs after filling up your motorcycle with gas, make certain that the 
gas isn’t the culprit before you change anything in the ThunderMax ECM. It is not 
uncommon for fuel blending to vary in different regions of the country.  
 
Another common scenario is related to old gas, if you start your bike at the 
beginning of the riding season, with last season’s gas still in the tank, the first thing 
you need to do is drain the old gas and replace it with fresh gasoline. Due to the 
increasing amounts of alcohol in the gasoline that’s being refined and blended today, 
the shelf life has gone down on common gasoline. The alcohol separates from the 
gasoline and changes the properties of the gasoline. If you think you may be 
experiencing a problem related to old gas, change the gasoline before putting any 
additional time into it. Low octane fuels are not recommended for these engines, and 
will cause tuning issues if used.  
 
In addition you may need the Harley-Davidson® Electrical Diagnostic Manual. 
These manuals are model-specific and contain valuable information in 
troubleshooting issues with EFI equipped motorcycles.  The troubleshooting charts 
that follow are set up to aid the technician in solving issues that you may be 
experiencing on a motorcycle equipped with the ThunderMax EFI system.  If the 
problem is not related to the ThunderMax ECM, you will need to refer to the service 
and diagnostic manuals for the specific model in question.  
 
If the troubleshooting chart does not help you identify the problem that you are 
facing, please refer to the section in this manual titled “Tech Questions and 
Support,” then follow the instructions on how to contact Zipper’s Performance 
Products with the problem at hand. If you do not follow these instructions and 
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call for help without any specific information that is requested, your technical 
support call will not be productive.  Zipper’s wants you to get the most out of our 
technical support crew and adjustments are easy to make; however without all of the 
information at hand we will not be able to accurately help solve your problems.  
 
The preceding pages were developed from technical support questions raised 
directly by the users of the ThunderMax ECM. Use this as a reference for 
troubleshooting before calling the Product Support line, as many discussions in the 
next section are regularly explained on the tech line. Using the manual will reduce 
the amount of time needed to identify and correct any issues at hand.  
 
Some of the descriptions may be brief in the following diagnostic flow charts; 
however any topic can be easily cross-referenced by using the Glossary, 
Index, Table of Contents, or the Visual Index in the Appendix.  
 
Important note- If you need to change a faulty or damaged TSSM on the 
motorcycle you will likely not be able to start the engine with the replacement 
TSSM. This will require you to remove the ThunderMax module and install the 
O.E. ECM so you can properly access and activate the new TSSM module thru 
digital tech. For further information refer to the electronic diagnostic manual 
for your motorcycle. 
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Starter Cranks, Engine Will Not Start 

Fuel Pump 
Make certain that 
the Fuel pump is 

operating properly; 
you should hear it 
pressurize the fuel 

rail when the 
ignition is turned 

on.   

Ignition 
System 
Issue 

Crank Sensor 

Pinched or 
Bare Wire 
to the Fuel 

Pump, 
near the 
gas tank 

Fuel Pump 
Fuse is 
blown 

Damaged 
ECM 

Check ECM 
connections, 

Battery, 
Replace 

ECM if non-
functional

Check for 
the Cause 

of the 
Blown 
Fuse – 

 
Replace 

Fuel Pump 
Fuse 

Repair or 
Replace 
damaged 

wiring 

Check Spark 
Plugs for 

spark. Leave 
existing plugs 
in the heads, 

add new spark 
plugs to the 
plug wires. 

Link to the 
ECM, Read 

Module Maps 
and Settings, 

check value of 
Main Relay 

LOC in Basic 
Settings 

Link to the 
ECM, Read 

Module Maps 
and Settings, 
Monitor the 

Engine Speed  
while cranking 

the starter (RPM 
should read 200-

350 RPM) 

Check 
Battery 
Voltage 

Replace 
Crank 

Position 
Sensor if 
battery is 

OK 

Faulty 
Wiring 

Faulty 
Ignition 

Coil 

Weak 
Battery, 

Low 
Voltage

Replace 
Faulty 

Components

Zero 
Value = 
Replace 
Crank 
Sensor 



Diagnostics and Troubleshooting________________________ 

 118

IAC Plunger Check 
Entering from the throat of the throttle body, probe with a soft tool 
like a spray tube from an aerosol can into the IAC port until you 

reach the face of the IAC plunger. Make certain the handlebar switch 
is in Run, turn the ignition switch on and then “off.”  The IAC 

plunger should extend out (closing the port) and then retract (opening 
the port) to a home position every time the switch is turned off. 

IAC Plunger does 
not move 

IAC Plunger operates 
correctly 

Will Not Idle / Starts and Stalls 

Wiring Issue 
Check for 
broken or 
incorrectly 
wired IAC 

wires 

Damaged 
Driver in 

ECM 

Defective 
IAC 

Motor 

Replace 
ECM 

Replace 
IAC 

motor 

Check IAC 
Wiring Plug 

Correct Throttle Body?
2001-2005 Throttle 

Bodies will not directly 
work on 2006 and later 

motorcycles. The plug is 
physically the same; 

however the wires are in 
different pin locations. 

Contact Zipper’s for a pin 
schematic to correct the 

early to late wiring 
differences. 

AFR 
too 

Rich 

Wrong 
Map 

Loaded 

Improper 
Calibration 
of Throttle 
Body Blade

See Page 
96 for a 
Blade 

Calibration 
Procedure 

Load new 
Map, 

Clear all 
Offsets 

Adjust AFR 
Targets at idle 

RPM if 
necessary

Link, 
Monitor, 
Check the 

Raw 
Throttle 
Position 
Value 

 
Factory = 
75 - 125, 

 
 Zipper’s = 

50-54 
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Erratic or Wandering Idle

IAC Port Test 
At a warm idle, remove the air filter and cover, place one finger over 

the IAC port in the top of the throttle body bore. Normally 80% of 
the air required for the engine to idle passes through this port when 
the throttle is closed.  Blocking this air off should cause the idle to 

fall to about 300 RPM, and perhaps stall. 

Engine Speed Varies 
Up and Down 

Engine Stalls as soon 
as the Throttle is moved

Check Diagnostic 
Trouble Codes 

No Codes 
recorded 

Intake Manifold 
Seal Leak 

Faulty Throttle
Position Sensor 

(TPS) 

Lean AFR 

Repair / Replace  

Confirm Map 
Selection 

Replace with 
another Map, 
Clear IAC and 

CLP Offsets 

Richen AFR 
Targets  

Hold the Throttle 
in a different RPM 

range (different 
Map page), see if 

the AFR is correct. 
Modify only the 
idle RPM map 

page

Correct Base 
Map  

TPS Sensor 
Failed 

Broken 
TPS wire 

connection

Broken 
Throttle 

Shaft 

Faulty 
TPS 

Sensor

Physical 
Inspection

Repair 
Replace

Link to the ECM
Turn on the 

Monitor Gauges. 
Twist the throttle 
and monitor the 
movement of the 
Throttle Position 

cursor. 
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Check that you have  
Firmware version 4.0 or higher 

Link to the ECM 
Read Module Maps & Settings 
Open the IAC Stops vs. Engine 

Temperature map page 
See page XX to reference a proper 

IAC Stop curve shape. 

Upgrade V3.2 or earlier 
Firmware, see page 131. 

Clear all Offsets, IAC 
and CLP.  

High Idle 

Erratic Tuning 
Blocks Check for 
any tuning blocks 
that are drastically 

outside of the 
shape of the curve. 

Correct, 
Smooth 

IAC curve

Clear Learned Idle 
Control Adjustments 

(IAC) 
Smooth the erratic 
blocks to the shape 
of the curve. Move 
the erratic blocks 

down to the rest of 
the curve, do not 

move the curve up 
to the erratic 

blocks. 

Incorrect IAC Stop 
Targets in the Basic 

Settings 

Clear “Learned Idle 
Control Adjustments 

(IAC)” 

Test after clearing the 
Learned IAC Targets 

If the problem still exists 
– See Page 94 on how to 

manually Lower IAC 
Stops 
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Backfires on Deceleration 

New Problem – Motorcycle 
did not backfire after 

installation, but now it is 
backfiring and the ride 
quality has degraded. 

New Installation of 
ThunderMax  

Validate that the AFR is 
stable at normal operating 

temperature  

Replace 
Oxygen 
Sensors 

Link to the ECM, 
Read Module Maps and Settings 

Read Diagnostic Codes 

Error 
Code 

Found 
Clear 

Diagnostic 
Codes 

No Error Codes – 
Check Closed 
Loop Module 

Settings – make 
certain Closed 

Loop is activated

Check Closed 
Loop Module 

Settings – make 
certain Closed 

Loop is activated 

Write Module Maps and Settings to 
the ECM 

If the condition hasn’t changed, 
Verify the Calibration of the O2 

sensors. (Stable 19.36 AFR on each 
sensor once powered up, but before 

startup, page 114) 

Clean 
Oxygen 
Sensors 

Unstable 
AFR – 
Update 

Base Map 
Definitions 
and find a 

closer Base 
Map

Stable AFR – 
Check Closed 
Loop Module 

Settings – make 
certain Closed 

Loop is activated

Check 
Firmware 
Version – 
Update to 
4.5 or later

Use the 
new Decel  
Fuel Cut 

Settings in 
the Basic 
Settings 
window 
page 64 

Check for a 
damaged sensor 
or wiring, make 
certain that the 
connectors are 
all in place and 

tight. 

Make certain 
that the power 
cable for the 
AutoTune 
module is 

plugged in to the 
Diagnostics Port
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Check Engine Light Illuminates

If the Check Engine light comes 
on regularly during normal 

operating temperatures,  
Link to the ECM 

Read Module Maps and Settings 
Read Diagnostic Codes 

High Heat not 
present when 
Check Engine 
Light came on 

If no error codes are present, and 
the Firmware is V4.5 or higher: 
 
1.) Check Basic Settings Value for 
“Engine Temp Alarm Threshold” 
 
2.) Read Warranty Info Data (Head 
Temps Log)

If the light does 
not appear again, 
no action required

If the engine 
temperatures are 
acceptable and the 
bike is operating 

correctly, raise the 
value in the 

“Engine Temp 
Alarm Threshold.”

If the head temperatures are 
excessive, begin troubleshooting the 

high heat situation. This could be 
caused by lean AFR Targets, the 

combination of parts, or even 
excessive blockage of air to the 
cooling fins (lower fairings on 

Touring models). 

High Heat Present when 
the Check Engine Light 

came on 

Engine Temperature 
Exceeded the “Engine 

Temp Alarm Threshold” The Check Engine light 
functions similarly to the 
factory warning system 

(Version 4.5 Firmware or 
higher).  

Link to the ECM,  
Read Diagnostic Codes 

If no codes are present, 
follow the factory HD 

Electrical Service Manual 
for instructions on how to 
decode the factory “Check 

Engine Light” 
If you do not 

have V4.5 
Firmware, 

Upgrade the 
Firmware 
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GENERAL PERFORMANCE PROBLEMS 
 
EFI equipped engines need the same basic elements to function properly as 
carbureted engines.  If you are experiencing a performance problem, first review all 
installation instructions and verify all steps were followed, then: 
   

• Electrical Issues - Check for loose battery cables or other loose electrical 
connections. Then check for a failed sensor.  View the Diagnostic 
Troubleshooting Codes.  

• Spark - Check the spark plugs for proper color or soot inspect the air cleaner 
for dirt. If the motorcycle has an operational issue before installing the 
ThunderMax ECM, it is probable that there’s another problem on the 
motorcycle that you need to solve before you proceed with tuning.  

• Air / Fuel Quality - Ensure the engine is receiving clean air and good fuel. If 
the fuel is from last season or has been varnishing for several months, drain, 
flush and start over with fresh fuel.  

• Mechanical Issues - Check for a mechanical issues such as loose hardware 
on the throttle body, improper throttle blade setting, leaking intake manifold 
seals, fuel delivery problems (in-tank fuel filter and fuel line), injector 
problems, wiring, wet sumping, or poor ring seal.  

 

GENERAL INSTALLATION NOTES 
 

Lights on the Console / Speedometer:  On certain models, the turn signals or 
other lights in the gauges / gauge cluster may flash when the ignition switch is 
initially turned on.  No action is required if the lights work properly during normal 
operation.  
 
Engine Light: If the engine light illuminates at high temperature during operation of 
the motorcycle, the ThunderMax ECM is warning you that the cylinder head 
temperature has reached the danger zone of 325 degrees. Firmware 4.6 or higher 
will allow you to adjust the setting for the temperature that the warning light 
illuminates, with a default value of 350 degrees. Continued operation (without a 
cool down period) could cause severe engine damage! See page 73 for more 
detail on this feature.  
 
Engine Light / Battery Light at Startup: The ThunderMax ECM operates 
differently from the factory ECU. When starting, the ThunderMax ECM goes through 
a sequence of events testing and illuminating each individual light at startup. 
Although this sequence is different than the factory ECU, the sequence is normal for 
the ThunderMax ECM.  
 
Low Fuel Light (Up to 2007 models)- The low fuel light will operate exactly the 
same whether you are using the ThunderMax ECM or the factory ECM. Our in 
house testing has found that the low fuel light does not activate at the same time on 
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every tank. What this means is that the volume of fuel left in the tank when the low 
fuel light comes on, varies almost every time it is activated. This inconsistency is not 
related to the ThunderMax ECM or any other aftermarket ECM on the market.  
 
Battery Light Function:  If the light comes on during idle speed at operating 
temperature, this light is indicating low voltage of your charging system. Voltage can 
be viewed at the monitor window.  Charging systems are not a function of the ECM.  
Before you take any action, verify voltage at idle which could be low due to 
conducting the initializing and other diagnostic work with the ignition switch on.  
Recharge the battery, verify that the charging system is working properly and review 
the light function.  If the problem persists, contact Zipper’s.  
 
Removing, Changing or Charging the Battery:  When installing the ECM for the 
first time, remove the fuse for the ECM before disconnecting or reconnecting the 
battery.  Hot-swapping components could promote a premature failure, which could 
result in damage to the controller.   
 

Always pull the ECM fuse before disconnecting or reconnecting the 
battery! At any point if the ECM Fuse has been pulled, including 
battery replacement, the ThunderMax ECM must be re-initialized. 
Failure to do so may require linking to the module to fix the IAC 

Stops location. See the initialization procedure on page 11. 
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ABOUT THUNDERMAX 
 
The ThunderMax EFI is a complete, stand alone ECM for all Delphi based 
motorcycles.  This high-resolution Alpha/N-based system is the most advanced 
engine management system available. The ThunderMax ECM is not a post-fuel 
devise, or a “signal modifier”, it is a complete factory ECM replacement.  The same 
technology is also available for all Magnetti-Marelli based H-D 1997-2001 
motorcycles. 
  
The ThunderMax EFI system is a joint development and distribution project between 
two industry leaders, Zipper's Performance Products and Thunder Heart 
Performance Corp.  Zipper's Performance Products is a leading developer and 
producer of engine kits and performance components for the H-D aftermarket 
industry.  Thunder Heart Performance Corporation engineers, designs and 
manufactures high technology systems and components for the motorcycle industry. 
  
Our companies are committed to developing and improving the best engine 
management and fuel injection products in the industry. Our staff is dedicated to 
customer support. 
  
The ThunderMax comes with a 3 year limited warranty.  
 
For additional information including ThunderMax Cams by Red Shift as well as 
software and instruction updates, please visit the ThunderMax website, 
www.Thunder-Max.com .
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Section 6: 
 

Updates 
 
 
 
 
 
 

An Internet Connection is required for all updates.
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UPDATING THE SMARTLINK SOFTWARE 
 
To maintain the most current version of SmartLink IV, use the update function in the 
software. An Internet Connection is required for all updates. 

 
Select Configure > SmartLink Update to begin the update process, as shown below. 
 

 
 

The following window will appear: 
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One of two choices will appear: 
 

 
 

 
 

Follow the instructions provided by the SmartLink IV update windows to update your 
version of SmartLink IV. When complete, open SmartLink IV and select Help > About 
SmartLink… to check the version number that is currently installed on your computer. 

Software is 
up to date! 
 
No action 
required. 

New 
Software 
Available! 

 
Proceed 
Forward 
with the 
Update 
Process 
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With the Vista Operating system, if you receive either of these two errors, you will need 
to reinstall SmartLink IV before you can proceed with any updates.  

 

 
 

 
 
Both of these errors occur when an earlier version of SmartLink IV was loaded, but 
without the special instructions for the Vista operating system. Current versions of 
SmartLink IV (2007 & newer) do not require special installation instructions for Vista.  
 
Uninstall SmartLink IV from your computer (Control Panel > Program Manager). Now 
install SmartLink IV 2008.0.2 onto your computer, and follow the instructions given on 
screen during the installation. Any additional updates or upgrades can now be utilized 
without special instructions.  
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UPDATING THE BASE MAP DEFINITIONS 
 
 
To ensure that you have the complete and up to date Base Map Library, select the 
“Update Definition File” button on the “Base Map Name Encoding” window, as shown 
below.  
 

 
 
You must be connected to the internet to update the Base Map Definitions as well 
as retrieving any available new Base Maps. The SmartLink IV Installation CD does 
contain the base map library; however it is only as current as the CD itself. Versions 
2008 and later will automatically download any new base map files when the definition 
file is updated. Previous versions will only download a list of available base map 
choices. Again, an internet connection is a requirement for updating the 
SmartLink IV software. 
 
It is simply good practice to update the definition file when searching for a new Base 
Map file. Not only are new maps constantly being created, but the older Base Maps are 
updated occasionally as well. Once updated, you may proceed with selecting an 
appropriate Base Map for the current engine combination you are working with.  
 
If you are satisfied with the operation of your current Base Map, chances are a new 
Base Map will not make a significant difference to the operation of the motorcycle. 
Updated maps could contain spark curve or fuel management changes, or even 
different fuel economy strategies. 
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UPDATING THE FIRMWARE 
IN YOUR THUNDERMAX ECM 

 
For any modules with a Firmware version of 3.2 or higher, you can update the 
firmware, if an update is available, through the SmartLink software. You must be 
linked to the ThunderMax ECM to update the firmware in the module. An Internet 
connection is required to download the Firmware. Once the firmware file is 
downloaded, you do not have to be connected to the internet to upload the new 
Firmware to the ThunderMax ECM. There are two stages in updating the Firmware 
in the ThunderMax ECM.  
 
First Download  
 
 Stage 1: Check for an update, and download the latest Firmware onto your 

computer. 
 

 Stage 2: Link to the ThunderMax ECM and upload the newly downloaded 
Firmware to the module.  

 
Both stages are fully covered in the following pages. Both require that you are linked 
to the ThunderMax ECM, and have read the module map and settings.  
 
To begin the Firmware update procedure: 
 

1.) Link to your ThunderMax ECM 
 

 
 

2.) Select File > Read Module Maps and Settings 
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Stage 1: Downloading an Updated Firmware 
 
 
Select Configure > Firmware > Check for Firmware Upgrade to see if there is an 
updated Firmware available for your ThunderMax ECM.  
 

 
 
If an updated firmware is available for your ThunderMax ECM, the following window 
will appear: 
 

 
 

If you select the “OK” button, the firmware download will begin. Once completed, the 
following window will appear.  
 

 
 



____________________________________________Updates 
 

 133

 
Stage 2: Uploading a New Firmware Version  

into the ThunderMax ECM 
 
Link to the ThunderMax ECM, and Read Module Maps and 

Settings. SmartLink 2008.0.2 and newer will automatically read the map from your 
ECM before any firmware upgrade can begin.  

 
To upload the new Firmware to the ThunderMax ECM, select Configure > Firmware 
> Upgrade Module Now, as shown below. You must be linked to the ThunderMax 
ECM to perform any Firmware upgrades.  
 
 

 
 
Once selected, the following window titled “Module Detection” will appear: 
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Follow the instructions on the “Module Detection” window: 
1.) Turn off the Ignition Switch for 20 seconds. 
2.) Turn on the Ignition Switch 

 
The update process will now automatically begin. The following window will appear, 
allowing you to select the most recent version of the Firmware that you’ve 
downloaded onto your computer. Select the most recent version of the firmware, and 
select the “Open” button, as circled below.  
 

 
 
Once the file has been opened, the following window will appear titled “Module 
Detection.” Follow these instructions and your firmware update will be update on 
your ThunderMax ECM. 
 
Some Gen 1 modules cannot accept Firmware version 4.5 or higher. SmartLink will 
tell you if it is incompatible with your module version, as shown below. Always select 
the newest firmware date that SmartLink will allow you to load.   
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Follow the instructions on the “Module Detection” window: 
1.) Turn off the Ignition Switch for 20 seconds. 
2.) Turn on the Ignition Switch 

 
If the Firmware upgrade process is successful, you will see the following status 
window appear, titled “Transferring Data.”  
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Once the transfer completes, the “Module Detection” window will appear again.  
 

 
 

Follow the instructions on the “Module Detection” window: 
1.) Turn off the Ignition Switch for 20 seconds. 
2.) Turn on the Ignition Switch 

 
 

Lastly, “WRITE Module Maps and Settings” to complete 
the Firmware Upgrade process. If you neglect to write the map 
back to the ECM, errors will arise that will keep the motorcycle from 
operating correctly.  

 
 

The Firmware is now upgraded in your ThunderMax ECM. To check the firmware 
version on your ThunderMax ECM, simply open SmartLink IV, Link to the ECM, and 
select Help > About SmartLink…, as shown below. The “SMLIV” window that pops 
up will display the current software and firmware versions.  
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INDEX 
 

Accel Fuel…………………………………………………  64, 67 

AFR Correction…………………………………………… 62, 100 

AFR Override………………………………………………67, 83, 111 

Auto-Tune…………………………………………………. 8-28, 82 

Base Map…………………………………………………..31, 41 

Basic Settings…………………………………………….. 64, 67 

Closed Loop Module Settings……………………………82 

Cranking Fuelflow…………………………………………64, 71 

Diagnostics………………………………………………...112 

DTC Warnings……………………………………………. 79 

Engine Monitoring…………………………………………47  

Final Drive Ratio…………………………………………. 64, 70 

Gear 6 Min TPS………………………………………….. 64, 71 

Hot Keys……………………………………………………86 

IAC Home Position………………………………………. 64, 70 

IAC Max Learning Offset………………………………… 64, 70 

IAC Min Learning Offset…………………………………. 64, 70 

IAC Override……………………………………………… 82 

IAC Stop……………………………………………………94 

Idle Speed………………………………………………… 62, 70, 90 

Ignition Timing……………………………………………. 103 

Initial Fuel Pulse…………………………………………. 64, 71  

Initialization (Module)……………………………………. 11, 15, 21 

Loading Base Map Files………………………………….31, 41 

Linking…………………………………………………….. 38 

Main Relay Loc…………………………………………… 64, 73, 117 

Map Notes………………………………………………… 44 

Module Configuration……………………………………. 64 -82 

Monitoring………………………………………………….47 

Monitor Logging / Replay…………………………………55 
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Performance Problems………………………………….. 123 

Reading from the ThunderMax ECM……………………42 

Rev Limit……………………………………………………64, 66, 67 

SmartLink IV Installation………………………………… 27 

SmartLink File Management……………………………. 43 

SmartLink Map Database……………………………….  31 

SmartLink Update…………………………………………126 

Speedometer Calibration………………………………..  64, 69 

ThunderMax ECM Installation…………………………. 9 

Tuning Map Tree…………………………………………. 62 

Tuning Overview…………………………………………. 89 
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GLOSSARY OF TERMS USED 
 

Accel Fuel – Factor of fuel enrichment during rapid throttle movement. 
 
AFR (Air Fuel Ratio) – Percentage of air and fuel as measured from a single engine 
cycle. Example an AFR of 14: 1 = 14 parts of air per 1 part of fuel by weight.   
 
AFR Correction – Percentage of additional or reduced fuel to the base map at a 
specific operating condition. 
 
AFR Override – Allows a single AFR variance from the map target AFR settings on 
each closed loop map page. 
 
Auto-Tune – A Plug and Play add on for the ThunderMax ECM, allowing the use of 
closed loop feed back to make lasting adjustments to the base fuel map. These 
adjustments may be needed due to degradation of fuel components, manufacturing 
tolerances in the throttle body, IAC motor, TPS, injectors, or any other component 
variations.  
 
Barometric Pressure – The measured atmospheric pressure at the ECM, this is a 
variable factor relative to absolute atmospheric pressure, and ultimately effects the 
AFR in your engine.  
 
Base Ignition Timing – This displays the calculated ignition timing from the base 
map before corrections are applied. 
 
Base Map – A set of curves that determine the amount of fuel and ignition timing 
required for each operating condition, for one engine configuration. 
 
Base Map Definitions – The Base Map Definitions are the strings of data that 
display the parts used in each Base Map File. This is updateable with a high speed 
internet connection. The update will reveal any new Base Maps added to the Base 
Map Library by Zipper’s.  
  
Basic Settings - A window used to observe / change the basic module settings 
such as Idle RPM, Speedometer Calibration and IAC learning offsets, etc.   
 
CL (Closed Loop) – Meaning the use of feedback or reference of set point value to 
adjust Offsets to adjust the fueling output. 
 
CL Corr Front – Front cylinder percentage Adjustment Pre & Post Auto Tune  
  
CL Corr Rear –   Rear cylinder percentage Adjustment Pre & Post Auto Tune  
 
CL Status – A value which can be helpful with tech support to diagnose a problem 
related to the closed loop feedback system.   
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Closed Loop Processing – The use of a feedback sensor (oxygen sensor) to 
correct fuel delivery based on past air/fuel ratio readings.     
 
CLP Offset – The deviation of fueling values from the base map as a result of Auto 
tune corrections.  
 
Cranking Fuelflow – % of fuel supplied during engine startup mode. 
 
Crank Position Sensor – Determines the precise location and speed of the crank 
shaft.  
 
DTC Warnings – Diagnostic Troubleshooting Code Warnings 
 
ECM – Electronic Control Module (or Engine Control Module or Electronic Control 
Unit (ECU) –  
 
EFI – Electronic Fuel Injection 
 
EGO –Exhaust Gas Oxygen (the oxygen content of exhaust gases) 
 
 EGO Front – Front cylinder real time reading  
 
 EGO Rear –   Rear cylinder real time reading  
 
 EGO Target – The desired target as per map settings 
 
Engine Monitor Gauge – A display window selected from the monitor page  
 
Final Drive Ratio – The option of “Final Drive Ratio” is only used on 2007 
motorcycles with a 6th Gear Indicator light. The default value that should be used for 
a 2007 motorcycle is 87. 
 
Firmware – The internal program which directs the functions of the ECM for fuel 
control, spark control etc. The Firmware is updateable with a high speed internet 
connection. 
 
Normal Operating Temperature – Cylinder head temperature between 240-285 
degrees Fahrenheit.  
 
Gear 6 Min Tps – Smallest value of throttle position that will allow 6th gear display, 
this setting is only used on 2007 and newer motorcycles. The default value for 2007 
motorcycles is 40. 
IAC (Idle Air Control) –A stepper motor which controls by- pass air function in the 
throttle body. The IAC’s main purpose is to control airflow requirements at idle. 
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IAC Home Position – A value which is used to increase or decrease the amount of 
by-pass air for the IAC port, used during the starting function only. 

 
IAC Max Learning Offset – The Maximum offset that the IAC stop can learn to.  

  
IAC Min Learning Offset – The Minimum offset that the IAC stop can learn to. 

 
IAC Override – Allows the user to freeze the IAC position at a desired value.  This 
may be useful for diagnostic purposes, but should not be used during normal 
operation.  

 
IAC Plunger – Tapered tip of the Idle Air Control motor which controls the by-pass 
air flow at Idle. 

 
IAC Stop – A virtual lower limit for the IAC position. 

 
IAC Stop Target – A numerical value indicating the target for the IAC stop setting. 
 
Idle Speed – The target in the software for desired engine speed at idle when at 
normal operating temperature.  
 
Ignition Timing – A variable point at which ignition spark occurs, measured by 
degrees of advance or retard relative to top dead center position of the piston.  
 
Initial Fuel Pulse – An adjustable setting that primes the cylinders for optimum 
starting time. This only occurs one time per ignition start cycle. 
 
Initialization (Module) –The process which calibrates the IAC position and TPS 
value to the module.   
 
Injector Duty Cycle – Percentage of time the injector is powered by the ECM per 
combustion stroke.  
 
Injector Size Compensation- Used to apply a fueling compensation to ALL fueling 
maps based on the ratio of the “Map Injector Size” versus the “New Injector Size”. 
 
Link –A term referring to the communication between the software and the module.  
 
Load Control Dynamometer – A modern Load Control “dyno” has an electronically 
controlled brake or loading devise added to allow tuning at specific RPM targets. 
This is the ideal setup for tuning EFI engines.  
 
Main Relay Loc – The routing of power in the ECM –Value of (2) for all Big Twins 
(1) for XL models. 
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Module Fueling Offsets – Offsets that have been learned by the ECM to correct the 
AFR at particular RPM and Throttle Positions.  
 
NADS Nitrous – Nitrous Assist Dry System – An electronic “Dry” nitrous system that 
uses the ThunderMax ECM to add fuel like a Wet system. This is a plug and play 
add-on to the ThunderMax ECM.  
 
Narrow-Band Oxygen Sensor – An oxygen sensor used to measure the amount of 
unburned oxygen in the exhaust stream of an operating engine. The term narrow 
band refers to the small range of AFRs that the sensor can report to the ECM.  A 
factory sensor is a narrow band, typically a 1, 3 or 4 wire oxygen sensor.  
 
Open Loop – No feedback “loop”; manual changes to the base map required to alter 
or adjust the AFR.  The ECM operates solely off of the Base Map File regardless of 
the engine’s operation.  
 
Oxygen Sensor – An electronic sensor that measures the proportion of (O2) in gas 
being analyzed. 
 
PointTrak – The specific location of the vertical curser to the point being adjusted.  
 
Rear Trim – Rear Trim is the percentage of fuel being trimmed from the rear 
cylinder injector’s pulse width to match the front and rear cylinder AFRs. 
 
Rev Limit – A “Basic Settings” value which limits the engine rpm. Please consult the 
manufacturer of your engine to find the maximum RPM recommended. This is meant 
to be a safeguard against potential damage caused by over-revving the engine 
beyond its mechanical capabilities.   
 
Session (Tuning) – Also known as a “Key Cycle Event”. Every time the ignition 
switch is powered off, then powered on again, a new tuning session begins.  
 
SmartLink Map Database – The SmartLink Map Database is a database of pre-
made, professionally tuned Base Maps that span from an 88” stock engine to a giant 
Zipper’s 124” engine.  
 
SmartLink Update –Allows user to check for updates, and when available update 
the SmartLink IV software through a high speed connection.  
 
Speedometer Calibration – The Speedo Calibration is a number that is used by the 
ECM to determine the vehicle’s speed. This value is a function of the vehicle 
transmission, rear pulley, tire diameter, etc.  
 
Stoichiometric Air-Fuel Ratio (Stoichiometry) – This is the Ideal balance of 
reactants and products for the chemical equation associated with the operation of 
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combustion. For gasoline applications, a stoichiometric mixture is found to have an 
air-fuel ratio (AFR) of 14.7:1, or 6.8% Fuel.  
 
TPS (Raw) - An unfiltered voltage signal which can assist with adjusting throttle 
blade settings. 
 
Tip Angle – Also known as Bank Angle, refers to a sensor which detects if the bike 
is tipped or banked to one side more than 45 degrees for longer than one second. 
Power is interrupted to Turn Signals, Starter Motor, Ignition Controller, Fuel Pump 
and Coil when this sensor is tripped.  
 
TPS (Throttle Position Sensor) – A potentiometer attached to the throttle shaft 
which communicates throttle position to the ECM using a voltage signal. 
 
Tuning Map Tree – The Tuning Map Tree is the leftmost part of the SmartLink IV 
Layout. This is where all of the individual tuning maps and module configuration 
options are located.  
 
Wide-Band Oxygen Sensor – A type of sensor which is capable of precisely 
measuring exact air/fuel ratios. 
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APPENDIX 
 

Drop Down Menus 
 
The following section is to be used as a quick reference when using SmartLink IV. 
All of the menus are dissected and a quick explanation of each option is given. Each 
explanation is accompanied by a page number, which references the section in this 
manual that fully covers the topic.  
 

Appendix Index: 
 

A1: File 
A2: EFI Maps 

A3: Map Editing Tools 
A4: Tools 

A5: Configure 
A6: Monitoring 

A7: Window 
A8: Help 
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Appendix A1: File 
 
The “File” Menu contains the standard 
menu options of New, Open, Save & 
Exit. In addition to the standard 
options, communication to the ECM 
can be performed through this menu 
with the Read / Write functions.  
 
 
 
 
 
 
 
 
 
 
 
 

 
The “New” option will allow you to open an 
“Untitled” Base Map File. Although you cannot 
create a new Base Map with the software, the 
“Untitled” Base Map is necessary when linking to a 
ThunderMax ECM with an unknown Base Map File 
loaded onto it.  
 
 
 
 
 

 
 
The “Open” option allows you to open a Base Map 
File, if you already know the name of the file that 
you need. When selected, the Base Map folder on 
your computer will be displayed, with all of the 
current Base Maps listed. If you do not know which 
Base Map file you need, please see the EFI Maps 
section in Appendix A2.  
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The “Close” option will close the Base Map file 
that is currently opened in SmartLink IV. By 
default, if changes have been made, SmartLink 
will ask if you want to save your changes.  
 
 
 
 
 
 
 
 
 
 
 
 
The “Save” option operates exactly like the “Save 
As…” option. When selected, the Base Map File 
Folder will be opened for file naming. This saves 
the map that is currently displayed in SmartLink 
IV, along with changes made to the Base Map File.  
 
 
 
 
 
 
 
The “Save As…” option allows you to save your 
tuning work to your computer. The ThunderMax 
ECM records any changes made, but it is a good 
idea to save your modified Base Map File under a 
new name to prevent it from being overwritten.  
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The “History” function of SmartLink IV will always 
be displayed between the “Save As…” option and 
the “READ Module Maps and Settings” option.  
 
This section will display the names of the last four 
Base Map Files that have been used on this 
particular installation of SmartLink IV. 
 
 
 
 

 
  
 
 
The “READ Module Maps and Settings” option is 
used for synchronizing SmartLink IV to the 
ThunderMax ECM’s Base Map File. This particular 
function will read the ECM’s Base Map and display 
it in SmartLink IV.  
 
 
 
 

 
 
 
The “WRITE Module Maps and Settings” option is 
also used for synchronizing SmartLink with the 
ThunderMax ECM. However, this option will write 
the map displayed in SmartLink IV to the 
ThunderMax ECM.  
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Appendix A2: EFI Maps 
 

 
 
The “EFI Maps” Menu contains all of the 
functions that you need to find a Base Map File 
for your application.  
 
 
 
 

 
 
 
The “Search – Load EFI Map” option open the 
“Base Map Search” window, which allows you to 
do a quick search for a known Base Map File. 
This option allows you to search the Base Map 
Files on your computer, as well as the SmartLink 
IV Database Library via the internet.  
 
  
The “EFI Map Listings / Definitions” option 
opens the Base Map Name Encoding window. 
This provides you with full access to browsing 
the Base Map File Database, loading a chosen 
Base Map into SmartLink IV, as well as an option 
to update your current Base Map File 
Definitions.  
 
 
 
The “De-Code Map Name” option opens the 
“Base Map Name DeCoding” window.  
 
This window allows you to take a Base Map File 
name, and dissect it to find out the combination 
of parts that the Base Map was created for.  



__________________________________________Appendix 

 149

 
The “Module Map Information” opens the Base 
Map Name Encoding window. This will also 
quickly tell you the engine configuration that 
was used when the Base Map File was 
constructed.  
 
 
 
 

 
 
The “Map Notes” option will display a window 
called Map Notes. If you haven’t used this 
feature before, it will load as a blank window. 
Please use this window to save any notes on 
the changes that have been made from the 
Base Map File.  
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Appendix A3: Map Editing 
 

 
The “Map Editing” menu 
allows you to manipulate 
the learning functions of 
the ThunderMax ECM.  
 
 
 
 
 
 

 
The “Clear “Learned Fuel 
Adjustments (CLP OFSET)”” option 
is used only with the AutoTune 
Closed Loop System. This feature 
will erase any learned offsets that the 
AutoTune system has created.  
 
 
 
 
The “Write Learned Idle Control 
Adjustments (IAC)” option allows you 
to set the previously learned IAC 
points as the Module Map File. This 
will update your Module Map and 
allow you to tighten up your learning 
ranges.  
 
 
 
 
The “Clear Learned Idle Control 
Adjustments” option will remove ALL 
offsets that ThunderMax has created 
for controlling the IAC function. This 
is necessary when significant 
changes to the engine combination 
are made.  
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The “READ Module Maps and Settings” 
option is used for synchronizing 
SmartLink IV to the ThunderMax ECM’s 
Base Map File. This particular function 
will read the ECM’s Base Map and 
display it in SmartLink IV.  
 
 
 
 The “WRITE Module Maps and Settings” 
option is also used for synchronizing 
SmartLink with the ThunderMax ECM. 
However, this option will write the map 
displayed in SmartLink IV to the 
ThunderMax ECM. 
 
 
 
 
 
 
 
The “Undo Edits” option returns any 
learned map points back to the original 
map point, as shown by yellow tracers. 
Simply put, the tuning blocks will return 
to the yellow tracers.  
 
 
 
The “Reset Undo (yellow markers)” 
option is used for altering the Base Map 
file in the ThunderMax ECM. This option 
lets you set the learned and adjusted 
map tuning blocks as the Module Map 
File points.  Simply put the yellow 
tracers are reset to reflect the ECM’s 
adjustments.  
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Appendix A4: Tools 
 

 
 
The “Tools” menu is primarily used when a change occurs to the engine 
combination that the ThunderMax ECM has already been used with.  
 
 

The “Injector Size 
Compensation” option 
opens up a window that 
will ask for the size of the 
existing injector and the 
new injector. This feature 
will determine the 
percentage fuel change 

between the two injectors, and adjust ALL of the map points by this factor.   
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Appendix A5: Configure 
 

 
 
The “Configure” 
Menu contains 
options pertaining 
to the settings of 
the ThunderMax 
ECM as well as 
SmartLink IV.  
 
 
 
 
 

  
 
The “Select Com Port” option 
should never need to be used, 
however if a problem occurs 
during the Linking process, this 
option allows you to specify 
which Com Port you are 
attempting to communicate 
through. SmartLink IV 
automatically finds the proper 
Com Port and rarely needs to be 
told which Port to use. This option 
is only for those rare instances.  
 
 

 
 
The “Firmware” option 
allows you to check 
and upgrade the 
firmware that is used in 
the ThunderMax ECM.  
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The “Authorize Product” option is only used when 
upgrading from End User software to Advanced 
User. This will only be used by tuners who have 
successfully been approved by Zipper’s to use 
the Advanced User software. The Advanced User 
Software is used in the creation of new Base 
Maps, specific equipment is required to properly 
create a Base Map. 
 
 
 
 
The “Closed Loop MODULE Settings…” option is 
only used with the Auto-Tune Closed Loop 
system. This will open a window that gives you 
several options on how to use the Closed Loop 
system on your application.  
 
 
 
 

 
The “Module Settings” 
option allows you to 
activate and control the 
NADS nitrous system 
and any supercharger 
system. These settings 
allow you to make 
changes to account for 
these power adders.  

 
 
 
The “Software Settings” option 
allows you enable or disable the 
Diagnostic Trouble Code data from 
being displayed when a link is made 
to the ThunderMax ECM.  
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The “SmartLink Update” option allows you to 
check and see if a newer version of SmartLink is 
available. You will need an internet connection 
to check for updates.  
 
The SmartLink software package is constantly 
being refined and upgraded, no matter what 
version you may have purchased, a free upgrade 
is always available as the software improves.   
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Appendix A6: Monitoring 
 

SmartLink IV Monitoring is 
used while performing live 
tuning, to keep a watchful eye 
on the vital engine data. Also 
the monitoring function 
allows you to customize your 
gauge layout, and record an 
operating session.  
 
The “Monitor Setup…” option 
allows you to choose which 
monitored values you want 
displayed on the main 
Monitor View page.  
 
 
The “Offset Simulation” 
option is solely used in 
Technical Support situations. 
This allows the Zipper’s 
Technical Support to see the 
offsets created in your 
module.  
 
 
 
The “Show Gauges” options 
allows you to toggle the 
visibility of the customized 
Monitor Gauges. 
 
 
 
 
 
The “Monitor Logging” 
option allows SmartLink IV to 
record a tuning or operating 
session for later review or 
replaying. Very useful when a 
tuning issue arises.  
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The “Monitor Replay” option 
allows you to open recorded 
Monitor Logs for review. This 
is a great tuning aide when 
troubleshooting operating 
issues.  
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Appendix A7: Window  
 

 
 
The Window menu allows you to maximize the Tuning Map window.  
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APPENDIX A8: Help 
 

  
 
The Help menu has four options which all relate to technical support for the 
ThunderMax ECM and SmartLink IV.  
 

 
The SmartLink IV Tuning Manual (pdf) is now 
easier to find, simply select this option and the 
latest Full Tuning Manual will open in Adobe 
Reader.  
 
 
 
 
 

 
The “Online Help Documents” is a link that takes 
you directly to the Instructions section of the 
ThunderMax website. Any additional support 
documents can be downloaded from this site.  
 
 
 

 
 
Simply select “ThunderMax Website” and now 
your default web browser will open directly to the 
ThunderMax site. The website contains all of the 
supporting documents, as well as information 
about additional ThunderMax products, larger 
throttle bodies, ThunderMax Cams by Red Shift, 
etc.  
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The “About SmartLink…” option will display the current SmartLink IV version 
number, as well as the current ThunderMax ECM Firmware version if linked to 
a module. 
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Name
Company
Address
Phone
Fax
Email

Year
Model
Engine Size
Manufacturer
Size

3 Air Cleaner Manufacturer
Manufacturer
Model
Manufacturer
Grind Number
Manufacturer

CLP enabled on Map & ECM?

Did you email your map or monitor log file to ProductSupport@ZippersPerformance.com for 
review?

10

Describe the 
problem that you 
are having, along 

with any 
symptoms 

experienced. 

Please include your firmware and software version numbers

9

Closed Loop (AutoTune)

AFR override checked?
Session map %
Maximum %

8 Open Loop
AFR at idle or WOT

7
Map Number       (16 Digit)

Is the map modified?

6 Cylinder Heads Estimated Compression Ratio

4 Exhaust System

5 Camshaft

2 Throttle Body

1 Motorcycle (Verify the year by the serial 
number on the stock ECM)

ThunderMax EFI Technical Support Information
FAX IN SUPPORT FORM - FAX TO 410-579-2835

Contact Information:


